Informatica® MDM Multidomain Edition
(Version 10.2 HotFix 1)

Informatica Data Director User Guide
# Table of Contents

**Preface** ................................................................. 7
Informatica Resources .................................................. 7
  Informatica Network ................................................ 7
  Informatica Knowledge Base ..................................... 7
  Informatica Documentation ....................................... 7
  Informatica Product Availability Matrixes .................. 8
Informatica Velocity ................................................... 8
Informatica Marketplace ............................................. 8
Informatica Global Customer Support .......................... 8

**Chapter 1: Introduction** ............................................. 9
Informatica Data Director Overview ............................. 9
Key Concepts ............................................................ 10
  Business Entities ................................................. 10
  Best Version of the Truth ....................................... 10
  Search and Compare ............................................. 11
  Merge ............................................................... 11
  Review Processes and Tasks .................................... 11
  Hierarchies and Relationships ................................ 12
Logging in to Informatica Data Director ...................... 12
  Configuring Microsoft Internet Explorer .................... 12
User Interface .......................................................... 13

**Chapter 2: Getting Started** ...................................... 15
Getting Started Overview .......................................... 15
Start Page .............................................................. 15
  Jaspersoft Reports .............................................. 16
  Social Media Feeds ............................................. 16
  Search Engine and External URLs ............................. 17
  Task Inbox ....................................................... 17
Refreshing Data in the Start Page ............................... 18
Sorting and Filtering Tasks ......................................... 19

**Chapter 3: Adding Business Entities** .......................... 20
Adding Business Entities Overview ............................. 20
  Data Validation in the Business Entity View ............... 21
Adding a Person Scenario ......................................... 21
Adding an Organization Scenario ............................... 21
Adding a Business Entity ......................................... 22
Adding a Business Entity with Data from DaaS Provider .... 24
Chapter 4: Finding and Editing Business Entities................................. 27
Finding and Editing Business Entities Overview........................................... 27
Search Page. .................................................................................. 27
Scenario for Editing a Business Entity......................................................... 29
Searching for Business Entities. ................................................................. 29
Filtering Business Entities................................................................. 31
Viewing and Opening a Business Entity......................................................... 32
Editing a Business Entity................................................................. 33
Adding and Editing Related Records......................................................... 34
   Scenario for Adding and Editing Related Records. ......................................... 35
   Adding a Related Record. ................................................................... 35
   Viewing Related Records. .................................................................. 37
   Deleting a Related Record. .................................................................. 37
   Editing the Relationship Details. ............................................................ 37
Deleting a Business Entity.................................................................. 38

Chapter 5: Resolving Duplicates.............................................................. 39
Resolving Duplicates Overview................................................................. 39
Match Process. .................................................................................. 40
Merge Process. .................................................................................. 40
Scenario for Duplicate Business Entities...................................................... 41
Resolving Duplicate Business Entities......................................................... 41
   Identify Duplicate Business Entities......................................................... 41
   Identify Duplicate Child Records.............................................................. 42
   Merge Duplicate Business Entities............................................................ 43
Resolving Duplicate Records in a Single Business Entity............................ 44

Chapter 6: Establishing the Best Version of the Truth.............................. 45
Master Records and the Best Version of the Truth......................................... 45
Scenario............................................................................................... 45
Establish the Best Version of the Truth......................................................... 46
Unmerge Cross-reference Records............................................................... 47

Chapter 7: Investigating Data Changes.................................................... 48
Investigating Data Changes Overview........................................................ 48
Investigating Data Changes Scenario.......................................................... 48
Comparing Data Before and After Events.................................................... 49

Chapter 8: Investigating Hierarchies and Relationships............................ 50
Investigating Hierarchies and Relationships Overview.................................. 50
Opening a Business Entity in the Hierarchy View........................................ 50
Displaying Entities and Relationships on the Canvas.................................... 51
Selecting a Layout ........................................ 51
Filtering Entities and Relationships ....................... 52
Hiding and Showing Entities on the Canvas ............... 54
Navigating the Canvas ..................................... 55
Setting Canvas Options .................................... 56
Investigating Related Entities ............................. 56
Viewing Entity Data ........................................ 56
Viewing Source Systems and Pending Changes .......... 57
Viewing System Columns .................................. 57
Viewing and Editing Relationship Details ................ 57
Viewing the Hierarchy for a Related Entity ............... 58
Viewing a History of Relationship Changes ............... 58
Changing Entities and Relationships for a Business Entity ............................................ 59
Adding an Entity to the Canvas ............................ 59
Adding a Relationship ...................................... 59
Editing an Entity from the Hierarchy View ............... 60
Deleting an Entity from the Hierarchy View .............. 60
Deleting a Relationship ..................................... 61
Sharing the Hierarchy View of a Business Entity ........ 61
Saving an Image of the Graph ............................... 61

Chapter 9: Participating in Review Processes ............ 62
Participating in Review Processes Overview .............. 62
  Example of a Review Process for Edits .................. 62
  Task Manager .............................................. 63
Receiving Task Notifications .................................. 66
Claiming Tasks .............................................. 66
Resolving Tasks .............................................. 67
  Reviewing Edited Business Entities ...................... 67
  Reviewing New Business Entities ....................... 68
  Reviewing Merge Proposals ................................ 69
  Reviewing Unmerge Proposals ............................ 70
Organizing Work on Tasks ................................ 71
  Sorting and Filtering Tasks ................................ 72
  Editing Due Date, Priority, and Other Task Properties 73
  Assigning Tasks .......................................... 74
  Disclaiming Tasks ........................................ 74

Appendix A: Review Processes Reference ............... 75
Review Processes Reference Overview .................... 75
  Update With Approval Workflow .......................... 76
  One Step Approval Workflow ............................. 76
  Two Step Approval Workflow ............................. 76
Preface

The *Informatica Data Director Business User Guide* explains how you can create, consume, manage, and monitor master data in an Informatica® Data Director (IDD) application.

Informatica Resources

Informatica Network

Informatica Network hosts Informatica Global Customer Support, the Informatica Knowledge Base, and other product resources. To access Informatica Network, visit [https://network.informatica.com](https://network.informatica.com).

As a member, you can:

- Access all of your Informatica resources in one place.
- Search the Knowledge Base for product resources, including documentation, FAQs, and best practices.
- View product availability information.
- Review your support cases.
- Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base

Use the Informatica Knowledge Base to search Informatica Network for product resources such as documentation, how-to articles, best practices, and PAMs.

To access the Knowledge Base, visit [https://kb.informatica.com](https://kb.informatica.com). If you have questions, comments, or ideas about the Knowledge Base, contact the Informatica Knowledge Base team at [KB.Feedback@informatica.com](mailto:KB.Feedback@informatica.com).

Informatica Documentation


If you have questions, comments, or ideas about this documentation, contact the Informatica Documentation team through email at [infa_documentation@informatica.com](mailto:infa_documentation@informatica.com).
Informatica Product Availability Matrixes

Product Availability Matrixes (PAMs) indicate the versions of operating systems, databases, and other types of data sources and targets that a product release supports. If you are an Informatica Network member, you can access PAMs at https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity

Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services. Developed from the real-world experience of hundreds of data management projects, Informatica Velocity represents the collective knowledge of our consultants who have worked with organizations from around the world to plan, develop, deploy, and maintain successful data management solutions.

If you are an Informatica Network member, you can access Informatica Velocity resources at http://velocity.informatica.com.

If you have questions, comments, or ideas about Informatica Velocity, contact Informatica Professional Services at ips@informatica.com.

Informatica Marketplace

The Informatica Marketplace is a forum where you can find solutions that augment, extend, or enhance your Informatica implementations. By leveraging any of the hundreds of solutions from Informatica developers and partners, you can improve your productivity and speed up time to implementation on your projects. You can access Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support

You can contact a Global Support Center by telephone or through Online Support on Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at the following link: http://www.informatica.com/us/services-and-training/support-services/global-support-centers.

If you are an Informatica Network member, you can use Online Support at http://network.informatica.com.
CHAPTER 1

Introduction

This chapter includes the following topics:

- Informatica Data Director Overview, 9
- Key Concepts, 10
- Logging in to Informatica Data Director, 12
- User Interface, 13

Informatica Data Director Overview

Informatica Data Director (IDD) is a data governance tool. Use Informatica Data Director to access the master data that is stored in an Informatica MDM Hub Store. Master data is organized by business entities. Business entities can be any type of top-level data that has significance for an organization, such as customers, suppliers, employees, or accounts. The master data represents the best version of the truth that the organization can achieve about the business entities.

An IDD application developer defines an IDD application that runs within Informatica Data Director. The IDD application defines the types of business entities that are meaningful to your organization.

Business users use an IDD application to perform the following activities:

- Add business entities
- Find and edit business entities
- Verify that the master records contain the most reliable data from all source systems, that is, the master records represent the best version of the truth
- Identify duplicate business entities and resolve them by merging the records
- Investigate historical changes to the data in business entities
- Unmerge merged business entities
- Manage relationships among business entities
- Participate in review processes for new and changed business entities
Key Concepts

To work effectively in Informatica Data Director, you need a basic understanding of Informatica Master Data Management concepts.

Business Entities

Business entities represent entities with significance to an organization. Organizations commonly define business entity types to represent customers, suppliers, employees, products, and accounts. For example, a business entity type might be Person. The customer John Smith is a business entity of type Person.

An organization can also define business entity types for data that is unique to the business. For example, a charity defines donors as a type of business entity. A medical device manufacturer defines unique device identifiers. Many organizations define more than one business entity type. The application developer controls which business entity types exist in the Informatica Data Director application.

In the MDM Hub Store, a business entity corresponds to a record in a base object table. The parent record contains identifying information for the business entity. The parent record contains links to child records that contain related information for the business entity, such as addresses and telephone numbers.

RELATED TOPICS:
- "Adding Business Entities" on page 20
- "Adding a Person Scenario" on page 21
- "Finding and Editing Business Entities" on page 27

Best Version of the Truth

When you view a business entity in Informatica Data Director, you view master data that is consolidated from source systems in your organization, including Informatica Data Director. The MDM Hub loads data from the contributing source systems. The load process uses a trust framework and rules to decide which cells from all the contributing source systems are most likely to contain accurate, up-to-date data. The consolidated business entity represents the best version of the truth (BVT) that is available across your organization.

Note: A BVT business entity is also known as master data, a golden profile, or a golden record.

For example, consider a car manufacturer that offers an incentive program to employees to buy cars. To construct BVT customer business entities, the data steward identifies the contributing source systems as the customer relationship management (CRM) system and the human resources (HR) system. The data steward trusts the employee address and telephone number from the HR system more than the same information in the CRM system, because employees are required to notify the human resources department of any changes to their contact information.

Informatica Data Director is a special type of contributing source system. Usually, data stewards set Informatica Data Director to the highest trust level of all contributing systems, which means that when a user edits data in Informatica Data Director, the edit is preferred over other source systems. You can also choose to override the automated BVT process and select a cell value you know is accurate.
For example, the following table shows data coming from two source systems and from Informatica Data Director:

<table>
<thead>
<tr>
<th>Source</th>
<th>Last Name</th>
<th>First Name</th>
<th>Telephone</th>
<th>Telephone Trust</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR System</td>
<td>Brown</td>
<td>Nancy</td>
<td>555-1235</td>
<td>80</td>
</tr>
<tr>
<td>CRM System</td>
<td>Brown</td>
<td>Nancy</td>
<td>null</td>
<td>50</td>
</tr>
<tr>
<td>Informatica Data Director</td>
<td>Brown</td>
<td>Nancy</td>
<td>555-1234</td>
<td>90</td>
</tr>
</tbody>
</table>

Because Informatica Data Director has the highest trust score for telephone numbers, the updated telephone number is used. The data steward can add rules that cause the trust value to increase or decrease for a system. For example, if the telephone number is subsequently updated in the HR system, the system might prefer that telephone number because it was updated most recently.

### Search and Compare

A best practice in data governance is to check for existing records before adding new records. When you begin adding a business entity, Informatica Data Director (IDD) searches for duplicate business entities.

You can preview the potential duplicate business entities as they appear and take one of the following actions:

- If more than one entity is a potential match for the entity you are adding, you can compare the entities side by side. If you find that the entities are duplicates, you can initiate a merge.
- If one entity matches the entity you are adding, you can open the entity and begin working with it. In this case, the entity that you started adding is discarded.
- If none of the entities is a match, you can continue adding the new entity.

The IDD application developer configures the fields to use in the search for potential duplicates.

### Merge

After you compare business entities, you can merge entities that appear to be duplicated.

When you merge a business entity, the root records of the merged business entity are consolidated into a single root record. The child records from each of the root records become child records of the merged root record.

**RELATED TOPICS:**
- "Resolving Duplicates" on page 39

### Review Processes and Tasks

A review process is an automated business process. When a user adds, edits, merges, or unmerges business entities, the action can initiate a review process. A review process ensures that business managers or data stewards review and ultimately approve the data before it becomes master data.

Your user role determines whether a change to the master data triggers a review. For example, if your user role permits you to add or edit data but not approve changes, then when you save an edit or merge business entities, the action triggers a review process.

A review process contains people activities. A people activity is a point in the review process when the process requires human participation. When an instance of a review process reaches a people activity, the
review process sends a task notification. Business managers and data stewards receive task notifications in
their task inboxes.

**RELATED TOPICS:**
- "Participating in Review Processes" on page 62
- "Example of a Review Process for Edits" on page 62

### Hierarchies and Relationships

A business entity can have relationships to other business entities. When the Hierarchy Manager is enabled
in an IDD application, you can view a graph that shows how a business entity is related to other business
entities.

You use the **Hierarchy** view to investigate relationships. You can view hierarchical relationships, such as an
employer-employee relationship, as well as relationships that are not hierarchical, such as peer relationships.

**RELATED TOPICS:**
- "Investigating Hierarchies and Relationships" on page 50

### Logging in to Informatica Data Director

To log in, you need the URL for Informatica Data Director (IDD) and your user credentials. If your
organization has created more than one IDD application, you also need the name of the application. If you do
not have this information, contact your MDM Hub administrator.

1. Open a supported browser, such as Chrome.
2. Enter the URL for Informatica Data Director. The URL has the following format:
   ```
   http://<MDM Server host name>:<MDM Server port number>/e360/mdm/entity360view/
   ```
   The **Log In** page opens.
3. Enter your user name and password.
4. Click **Log In**.
5. If prompted, select an IDD application.
   The IDD application opens and displays the **Start** page. Your user name appears in the top right corner
   of the application header.
   **Tip:** From the drop-down menu beside your user name, you can change your password and change the
   language of the user interface.

### Configuring Microsoft Internet Explorer

If you launch Informatica Data Director (IDD) in Microsoft Internet Explorer, to ensure that the data changes
appear in the user interface, configure Microsoft Internet Explorer to reload the web pages. Otherwise, after a
data change, you might see the cached data instead of the latest data.

1. Start Microsoft Internet Explorer.
2. Click **Tools > Internet options**.
3. On the **General** tab, configure the browsing history settings to check for newer versions of stored web pages every time you visit the web page.

The settings ensure that the latest version of the IDD pages appear.

### User Interface

The Informatica Data Director (IDD) user interface contains an application header and tabs.

The following image shows the user interface with the **Start** page displayed:

![User Interface Diagram](image)

1. Application header
2. Tabs
3. Page area
4. Page toolbar
5. Actions menu
6. User options, such as password changes

Tabs can be permanent or temporary. A tab contains a page area with one or more panels and a toolbar. In some tabs, you can switch between different views within the page.

Informatica Data Director has the following tabs:

**Start**

Use the **Start** page as your MDM dashboard. Managers and data stewards can view a list of review tasks in the task inbox. You might see other components, such as social media feeds, external URLs, and reports that display master data. The IDD application developer configures the **Start** page.

**Task Manager**

Managers and data stewards use the **Task Manager** to review changes to business entities. When you click a task in the **Start** page, the **Task Manager** opens and displays the business entity associated with the task.

**Search**

When you run a search from the application header, a **Search** tab displays the results of the search. You can open a business entity from the search results.
Opened business entity

In the search results, select a business entity and open the entity in an entity tab. The name on the tab identifies the opened business entity, usually by the name of the entity, but the tab name is configurable. You can view or edit the master data for the business entity in an entity tab.

In an entity tab, you can open the following views:

- To view and edit the master data for a business entity, use the Business Entity view.
- To view the source of the master data and establish the best version of the truth, use the Cross-reference Records view.
- To view past changes to the master data, use the History view.
- To view a business entity and potentially duplicate entities, use the Matching Records view.
- If the master data contains effective dates, you can view the scheduled changes in the Timeline view.
- If the Hierarchy Manager is enabled, you can view the business entity and its related entities in the Hierarchy view.

Other Tabs

The IDD application developer can configure other tabs.
Chapter 2

Getting Started

This chapter includes the following topics:

- Getting Started Overview, 15
- Start Page, 15
- Refreshing Data in the Start Page, 18
- Sorting and Filtering Tasks, 19

Getting Started Overview

After you log in to an application in Informatica Data Director, you see the Start page. The Start page is unique to your organization and to your user role.

Based on the Start page layout, you might be able to monitor data in reports, monitor social media feeds, run a search in an embedded search engine, and organize your task inbox.

Related Topics:

- "Adding Business Entities" on page 20
- "Finding and Editing Business Entities" on page 27
- "Resolving Duplicates" on page 39
- "Establishing the Best Version of the Truth" on page 45
- "Investigating Data Changes" on page 48
- "Investigating Hierarchies and Relationships" on page 50
- "Participating in Review Processes" on page 62

Start Page

Use the Start page as a home page and as a data monitoring dashboard.

The IDD application developer configures Start pages by user role. If you and a colleague have different user roles, your page might look different from your colleague's page.

A Start page can contain Jaspersoft reports that display views of selected master data. The page can also contain content from external sources, such as Twitter or a search engine. Managers and data stewards can view a list of review tasks in the task inbox.
Jaspersoft Reports

Jaspersoft is a business intelligence tool that organizations can use to create reports on master data. An IDD developer embeds the Jaspersoft reports in the Start page.

Jaspersoft reports can be static or dynamic. Static reports display the results of predefined criteria. Dynamic reports include input fields, where a business user can select different criteria to use with the report. Before you analyze the data in Jaspersoft reports, recalculate the reports to ensure that the data reflects the current master data.

The following image shows a static pie chart:

To refresh a Jaspersoft report to show current data, click Recalculate.

Social Media Feeds

A Start page can include social media feeds. Social media feeds can help you keep up with your organization's social media presence.

For example, the following image shows Twitter feed:
Search Engine and External URLs

A Start page can include an embedded search engine or other external URLs. With embedded external URLs, you can access the internet without leaving Informatica Data Director. For example, you might search for the internet for more information about a business entity or monitor competitor offerings.

The following image shows an embedded Bing search engine:

![Bing Search Engine](image1.png)

Task Inbox

A task is a request to participate in a review process. For example, you might need to approve a new business entity or review changes to a business entity. You receive task notifications in the task inbox. By default, the task inbox displays all available tasks. Available tasks include the tasks that are assigned to you and all unclaimed tasks.

The following image shows the task inbox:

![Task Inbox](image2.png)

1. Quick filters
2. Column filters
3. Sort by column heading
4. Refresh icon
5. Actions icon
The following table describes the elements in the task inbox:

<table>
<thead>
<tr>
<th>Inbox Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Filters       | You can use the following types of filters alone or in combination:  
- Quick filters. To see only your claimed tasks, select **My Tasks**. To see all tasks, select **Available Tasks**.  
- Column filters. Filters the tasks based on the task properties that are visible in the list. Use only one column filter at a time. |
| Refresh icon  | Updates the contents of the task inbox. |
| Actions icon  | A menu of actions that you can perform on a selected task. After you claim a task, you can edit task details. |
| Task Title    | A link that displays a short description of the review task. To review the business entity and take action on the task, click the task title. The business entity opens in the review panel. If your role permits it, you can edit the business entity from this view before taking action on the task. |
| ID            | The instance ID of the review process that generated the task. |
| Task Type     | The name of a people activity within the process. |
| Priority      | The task priority can be Low, Normal, or High. When generating tasks, the review process assigns the same priority to all tasks of the same type. |
| Due Date      | The date the task is due. The review process calculates a default due date based on the task creation date plus a predefined time period. |
| Status        | The status of the task can be Open or Closed. When the task status is Open, you can view the business entity associated with the task. |
| Owner         | The owner is the signed in user. You might also see Unclaimed tasks, which you can claim. |

## Refreshing Data in the Start Page

Before you perform an analysis of the data in the **Start** page, refresh the components to ensure that they display current data. You can refresh all components at the same time, or you can refresh some of the components individually.

**Note:** Third-party components might refresh themselves periodically. If so, the refresh rate depends on the API provided by the third-party component. For more information, contact the IDD application developer.

Perform one of the following tasks:

- To refresh all the components in the page, refresh your browser instance.
- To refresh only the task inbox, click the **Refresh** icon.
- To refresh a Jaspersoft report with current data, click **Recalculate**.
You can sort and filter the list of tasks in the task inbox. For example, you might want to review edited business entities before you review merge proposals.

The task inbox contains quick filters and column filters. You can use these two types of filters in combination to get specific results. For example, to see high priority tasks assigned to you, select the **My Tasks** quick filter and set the **Priority** column filter to **High**. In logical terms, filters are joined by the AND operator.

**Note:** You can set one column filter at a time. For example, you can narrow your list to Organizations and then further restrict the results to show only the Merge tasks for organizations.

1. Click either the **Start** tab or the **Task Manager** tab.
   
   The task inbox appears.

2. To sort the list of tasks by an attribute, click the column heading with that attribute name.
   
   For example, to sort tasks by task type, click the Task Type column heading.
   
   Sorts the tasks based on the values in the selected column. An up arrow beside the column heading indicates that the values are sorted in ascending order. A down arrow indicates descending order.

   **Note:** By default, the task inbox sorts ActiveVOS tasks case-insensitively. If there are more than the value of the IDD global property `CompositePagerTotalRecords` to sort, case-sensitive sorting is database dependent. For more information about `CompositePagerTotalRecords`, see the *Informatica MDM Multidomain Edition Informatica Data Director Implementation Guide*.

3. To filter the list, set filter criteria in any order.
   
   • To filter tasks by the most commonly-used criteria, select a quick filter:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>Shows tasks that you own.</td>
</tr>
<tr>
<td>Available Tasks</td>
<td>Shows tasks that you own and tasks that are unassigned. <strong>Note:</strong> You cannot view tasks that are assigned to other people.</td>
</tr>
</tbody>
</table>

   • To filter the task list based on an attribute in a column heading, set one column filter:

   **Note:** If the column filter fields are hidden, click **Filter on** to display the fields.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Title</td>
<td>Show tasks that contain the specified text. Enter the text that you want to search for in the task titles.</td>
</tr>
<tr>
<td>Type</td>
<td>Show tasks with the selected task type. Select a task type from the list, such as <strong>Final Review</strong> or <strong>Merge</strong>.</td>
</tr>
<tr>
<td>Priority</td>
<td>Show tasks with the selected priority, such as <strong>High</strong>. Select a priority from the list.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Show tasks that are due before or by the selected date. Click the field and then select a date from the calendar.</td>
</tr>
<tr>
<td>Status</td>
<td>Show tasks with the selected status, such as <strong>Open</strong> or <strong>Closed</strong>. Select a status from the list.</td>
</tr>
<tr>
<td>Owner</td>
<td>Show tasks that are assigned to the user. Enter a user name.</td>
</tr>
</tbody>
</table>

4. To remove filters, click the **Clear Filter** icon.
Chapter 3

Adding Business Entities

This chapter includes the following topics:

- Adding Business Entities Overview, 20
- Adding a Person Scenario, 21
- Adding an Organization Scenario, 21
- Adding a Business Entity, 22
- Adding a Business Entity with Data from DaaS Provider, 24

Adding Business Entities Overview

You can add business entities to the master data. The IDD application developer defines the business entities types, including the data and structure. The developer also designs the layout of the Business Entity views that open when you create an entity. Your application can have one or more Business Entity views.

Note: The name of the Business Entity view is customizable by the IDD application designer. The view you see might have a different view name.

Data entry form panel

The main panel in the view is the data entry form. Required fields have a red line.

Similar Business Entities panel

If the view contains the Similar Business Entities panel, as you enter data in required fields, Informatica Data Director generates a list of similar business entities for your review. Review the similar business entities before finishing the form. If you find the entity already exists, you can edit the existing entity instead of adding a new entity. If you are uncertain whether a similar entity is the same entity that you want to add, continue adding the new entity. If you add a duplicate business entity, Informatica Data Director can find and consolidate matching entities for you.

DaaS Providers panel

If the view contains the DaaS Providers panel, you can specify some basic information, such as the display name, and send the information in a request to a DaaS provider. The DaaS provider searches its database and returns a list of matching business entities. You can preview the data for each entity. You can compare two or more entities and specify which of the entities you want to use to create the business entity record.
Data Validation in the Business Entity View

When a user adds or changes data in the Business Entity view, Informatica Data Director checks the data against metadata and, optionally, validation rules. The metadata defines the expected format for the data, such as the data type or the number of characters permitted. The validation rules are cleanse rules or Informatica Data Quality rules.

Validation processes run at the field level, section level, and entity level:

- **Field level.** When you add or edit data in a field in the Business Entity view, a client-side validation process verifies that the data satisfies the metadata. For example, when you enter a date in a Date field and then navigate away from the field, the process verifies that you entered the date in the expected date format.
- **Section level.** When you apply all changes in a section in the Business Entity view, a client-side validation process verifies that all data satisfies the metadata and that the required fields contain data.
- **Entity level.** When you save a business entity in the Business Entity view, a server-side validation process verifies that data satisfies the metadata, the cleanse validation rules, and the Informatica Data Quality rules.

If user input does not satisfy the metadata or the validation rules, you see messages about the problems with the data.

Adding a Person Scenario

You are an insurance agent for a large insurance company. You have a new customer, Anthony Lomax, on the phone. You want to add Mr. Lomax as a business entity.

To add Anthony Lomax, you perform the following steps:

1. From the Create menu, you select Person as the business entity type.
2. In the Last Name field, you type Lomax. In the First Name field, you type Anthony.
3. In the Similar Business Entities panel, you see a potential duplicate, so you open the similar business entity.
4. You confirm with Mr. Lomax that he is not the same person as the existing Anthony Lomax, and then close the similar business entity.
5. You finish adding Mr. Lomax's information in the form.

Adding an Organization Scenario

You are with the marketing department of a company. You have a new customer, Time Warner which is an organization. You want to add Time Warner as an Organization business entity.

To add Time Warner, you perform the following steps:

1. From the Create menu, select Organization as the business entity type.
2. Fill in the required fields for the DaaS provider. In the Display Name field, type Time Warner. The Display Name field is a required field.
3. Select the DaaS provider and click Go.
4. Review the search results that the DaaS provider returns. You compare two or more entities in the search results.

5. Select the entities that are a potential match and click **Use this** to create the business entity.

6. If you do not find any potential matches, you close the search results, add data in the data entry form and click **Save** to create the business entity.

---

**Adding a Business Entity**

To add a business entity from an Informatica Data Director (IDD) application that uses the business entity model, start from the **Create** menu and select the type of business entity.

1. From the **Create** menu, click the business entity type that you want to add.
   
   Example: The IDD application for an insurance company defines a Person business entity type for customers. To add Anthony Lomax as a customer, a business user clicks **Create > Person**.

   An entity tab opens and displays the data entry form for the type of business entity. A red line on a field indicates a required field.

2. For each required field in the form, click the field, and type a value.

   **Note:** You can use the following conventions when adding text:

   - Type the complete search string or the search string with the asterisk wildcard character (*) for the business entity that you want to find. You can use the wildcard character at the end of the search string or in between the search string. For example, if you want to search for John, you can specify Jo* or J*n.

   - If the search is configured to suggest search strings, type a few characters of the search string, and select one of the suggested values as the search string.

     **Note:** The values are suggested when you search within a single business entity type.

   If the search string includes any of the following special characters, add a backslash as a prefix to the special character: +, -, &, ||, !, ( ), { }, ^, ~, ?, :, . If you do not add a backslash as a prefix to each special character, the search might return no results or incorrect results. For example, if you want to search for AT&T, the search string must be AT\&T.

   The following image shows a data entry form for the Person business entity type. The required fields are filled in.

1 Navigation menu.
2 Required field indicator
3 Changed field indicator

3. If the **Similar Business Entities** panel contains a list of similar business entities, review them.
   
a. In the **Similar Business Entities** panel, click the information icon beside the name of a business entity.

   The following image shows a **Preview** window that contains information about the selected business entity:

   ![Preview window](image)

   b. Check the other data values to see if the business entity is the same as the one you are adding.
      
      • If it is the same entity, click **Use this record**. When prompted for confirmation, click **Yes, proceed**. The work-in-progress entity is discarded and the tab closes. The selected business entity opens in an entity tab. You can edit data as required.
      
      • If it is not the same entity, click **Close**.
      
      • To review child records for the previewed entity without discarding the work-in-progress entity, click **View Business Entity**. The previewed entity opens in an entity tab.

   c. Review other similar entities in the same way.
   
d. If a business entity does not exist, return to the tab containing the work-in-progress business entity.

4. In the data entry form, add data in the optional fields.
   
a. Fill in the fields.
   
b. Optionally, add an image. Type a valid URL in the image field.

   **Note:** For best results, use an image that is a maximum of 200 x 200 pixels. For images, the MDM Hub stores the URL, not the file. If the location of the file changes, you must update the URL.

c. Click the **Apply** icon.
5. If the data entry form includes sections for child records, add child records to the sections.
   a. In the navigation menu, click a section name, such as **Address** or **Phone**.
      The view scrolls to the selected section.
   b. Click the **Create Child Record** icon.
      Fields appear where you can enter data.
   c. You can switch between a table view and a form view of the fields. Click the **Form** icon or the **Table**
      icon.
   d. Fill in the fields.
      The following image shows the **Phone** section in the form view:

   ![Image of Phone section in form view]

   1 **Table** icon. Click to view the fields within a table.
   2 **Form** icon. Click to view the fields within a form.
   3 **Create Child Record** icon. Click to add a child record to the selected business entity.

   e. Click the **Apply** icon.

6. After you finish adding data, click **Save**.
   A message confirms that the entity was created successfully. If your user role permits you to save data
   without a review, the application saves the business entity to the MDM Hub Store as active records.
   Otherwise, the application saves the business entity as pending records and initiates the review process
   associated with your role.

## Adding a Business Entity with Data from DaaS Provider

When you have Data as a Service (DaaS) integrated with the MDM Hub and configured for a business entity,
the DaaS Providers panel lists the DaaS providers. Use the data provided by a DaaS provider to add your
business entity record. To add a business entity, start from the **Create** menu and select the type of business
entity.

1. From the **Create** menu, click the business entity type that you want to add.
   For example, the IDD application for a company or enterprise defines an organization business entity
type for customers. To add Time Warner as a customer, a business user clicks **Create > Organization**.

2. Fill in the required fields for the DaaS provider. In the **Display Name** field, type Time Warner.
   **Note:** **Display Name** is a required field.

3. Move your cursor out of the **Display Name** field.
   You can now select a DaaS provider.
The following image shows a data entry form for the Organization business entity type. The required fields are filled in.

![Data Entry Form](image1.png)

4. In the **DaaS Provider** panel, perform the following steps to request a DaaS service for information about the business entity:
   a. Select a DaaS provider you want to use, and then click **Go**.
      The DaaS provider returns the search results, based on the display name of the organization.
      The following image shows the search results that the DaaS provider returns:

      ![Search Results](image2.png)

   b. Investigate if an entity in the search result is the one you would like to add.
      1. Select the entity and click **Preview**.
      2. If the data values do not match the entity that you want to add, click **Go back**.
      3. Review all entities in the same way.
   c. Optionally, if you want to compare two or more entities, select the entities, and then click **Compare**.
      The **Compare** page displays the data from the selected entities.
      The following image shows the Compare page:

      ![Compare Page](image3.png)

   d. To add the data from the search results, select one or more entities from the search results or from the Compare page, and then click **Use this**.
      All entities are merged to form a single business entity record.
      The business entity is created with the data from the DaaS provider.
      The following image shows the business entity that you added:
5. If the DaaS provider does not return results that match the entity you want to create, return to the tab containing the work-in-progress business entity.

In the data entry form, fill in the details, and click **Save** to add the business entity.
Finding and Editing Business Entities

This chapter includes the following topics:

- Finding and Editing Business Entities Overview, 27
- Scenario for Editing a Business Entity, 29
- Searching for Business Entities, 29
- Filtering Business Entities, 31
- Viewing and Opening a Business Entity, 32
- Editing a Business Entity, 33
- Adding and Editing Related Records, 34
- Deleting a Business Entity, 38

Finding and Editing Business Entities Overview

You can search for a business entity that you want to view, edit, or delete. If multiple business entities appear in the search results, you can use filters to refine the search.

After you find the business entity, you can open the entity in an entity tab. If your user role permits it, you can edit the data or delete the business entity. When you save changes, based on your user role, a review process might be initiated. In this case, Informatica Data Director saves the requested changes in a pending record until the review process ends. If the review ends in an approval, Informatica Data Director applies the change from the pending record to the active records.

Search Page

The Search page is a temporary page that appears when you perform a search from the Search box in the application header. A search returns a list of business entities that satisfy the search criteria.

Use the Search page to review the search results. You can expand a business entity in a search result to view the summary of business entity details. To refine the search results, you can use filters.

You can group the business entities that appear in search results based on the business entity types. If you group business entities, you can look for business entities in the relevant business entity type groups.

The following image shows a sample Search page:
The **Search** page includes the following sections:

**Search Results panel**

Displays the total number of results found and lists the business entities that are part of the search results. You can group the business entities listed in the search results by business entity type.

**Filter panel**

Displays the filter criteria to filter the search results. Use filters to refine the search results based on the filter criteria that you select or enter a value for. You can hide the **Filter** panel if you do not need to filter the search results.

**Results total**

Displays the total number of results found based on the search string that you enter in the **Search** box.

**Actions menu**

Displays actions that you can perform on the business entity. For example, you can open the entity in a view, such as the **Hierarchy** view, or you can create a task for the entity.

**Filter criteria**

Filter properties that you can select or enter a value for to refine search results.
Scenario for Editing a Business Entity

A customer named John Smith reports that he did not receive the product that you mailed to him. You want to check his address, correct errors, and redirect the product to the correct address.

You search for the business entity that represents John Smith. The search returns multiple business entities that have similar names. To refine the search, you filter the search results based on the city name, and some other criteria. You find the business entity for John Smith, which you select and open to view the address. You find that the address has an incorrect postal code. After you correct the address, you close and save the business entity. You ensure that you resend the product to the correct address.

Searching for Business Entities

You can search for business entities that you want to view, edit, or delete.

1. Optionally, in the Search box in the Informatica Data Director header, from the list, select the business entity type within which you want to search for the business entity.

   By default, **All** is selected, and Informatica Data Director searches within all the business entity types.

   The following image shows the business entity type list:

   ![Business Entity Type List](image)

2. In the Search box, perform one of the following tasks:

   - Type the complete search string or the search string with the asterisk wildcard character (*) for the business entity that you want to find. You can use the wildcard character at the end of the search string or in between the search string. For example, if you want to search for John, you can specify Jo* or J*n.

   - If the search is configured to suggest search strings, type a few characters of the search string, and select one of the suggested values as the search string.

     **Note:** The values are suggested when you search within a single business entity type.

     If the search results must contain the words in the search string, add the + operator before each search word.

     If the search string includes any of the following special characters, add a backslash as a prefix to the special character: + , - , , ! , ( ) , { } , ^ , " , ~ , ? , : , . If you do not add a backslash as a prefix to each special character, the search might return no results or incorrect results. For example, if you want to search for **AT&T**, the search string must be **\AT\&T**.

     If you want to search for a negative value, type the value in the search string without the minus character. For example, if you want to search for -5000, the search string must be **5000**.

     If you want to search a date, use a simple date format, such as **<Month> <DD> <YYYY>**, in any order and do not use a date format, such as **<YYYY>-<MM>-<DD>** or **YYYY-MM-DDThh:mmTZD**. For example, use November 20 2014 or 2014 Nov 20 as the search string.
3. Click the Search icon.

The following image shows the search results in the Search page:

Note: A smart search request does not return a rounded float value that the Entity 360 view displays when you search for the rounded value.

4. Optionally, you can group the business entities that appear in search results based on the business entity types.

The search results are sorted and moved to the relevant business entity type groups.

The following image shows search results in the Person business entity type groups, and search results in the Secure Person business entity type group:
5. To find the business entity that you are searching for, expand the business entity type under which you expect to find the business entity.

The business entity type expands to show all the business entities that appear in the search result and belong to the business entity type.

The following image shows the expanded results for the Person business entity type:

---

**Filtering Business Entities**

After you perform a search, you can refine the search results by using filters. For example, you can refine the search results for John Smith by filtering the results by the city name, Toronto.

1. Perform a search.
   
The search results appear in the **Search** page.

2. In the **Filter** panel, select or enter a value for the filter criteria that you require.
   
   **Note**: For a date and time field, you can specify the date in the filter, but not the time. The filter uses the default time as 00:00:00 UTC. Some numeric filters might appear in the scientific notation, even though the search results display the values in the decimal notation. For example, the filter might display 10544444.6 as 1.05444446E7.

3. Click **Apply Filter**.
   
The search results contain only the business entities that match the filters that you applied. A list of the applied filters appears below the Search box. You can remove a filter by clicking the X icon for the filter.
The following image shows that the search results contain only the business entities that matched the applied filters:

1. Applied filters
2. Filtered search results
3. Selected filters
4. To clear all the filter criteria, click Clear All.

 Viewing and Opening a Business Entity

You can view the summary of business entity details in the Search Results panel of the Search tab. To ensure that you open the business entity that you want, review the details for the business entity before you open it. You can open a business entity in the Business Entity view, the Data legacy view, or the Hierarchy view.

1. From the Search Results panel, select the business entity that you want to open.
   Note: A description with the prefix [Pending] means that the business entity has pending changes that are not yet approved. You can open the business entity, but you cannot make further changes until the review and approval process ends.

2. To verify that you have the correct business entity, expand the entry to display a few details about the business entity.

   The following image shows the expanded entry for John James Smith:

   3. Open the business entity.
To open the business entity in the default view, click the entity name.

Alternatively, click the Actions menu at the end of the row and select a view. The available views change based on the IDD application configuration.

The following table describes some of the views that might be available from the Actions menu:

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>View and edit the business entity in the legacy Data view.</td>
</tr>
<tr>
<td>Business Entity</td>
<td>View and edit the business entity in context with other sources of information about the entity.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>View a diagram of the relationships for the business entity.</td>
</tr>
</tbody>
</table>

4. If prompted, specify the effective period that you want to investigate.

The entity opens.

## Editing a Business Entity

If your user role includes the edit permission, you can edit a business entity in the active state.

**Note:** You cannot edit a business entity that is in the pending state because the entity has changes that are pending approval. You must wait until the review and approval process ends.

1. From the Search Results panel of the Search tab, open the business entity that you want to edit.

   The business entity opens in the selected view.

2. If the view is not your preferred view for editing, you can select a different view from the View list.

3. Click the Edit button.

   **Tip:** If the button is disabled, either you do not have permission to edit the business entity or the business entity has changes that are pending approval.
4. Edit the data in the root record as required.
   a. Click anywhere in the top section.
      The section becomes editable.
   b. Edit the data.
   c. Click the **Apply** icon.
5. Edit the data in child records as required.
   a. Expand the child section.
   b. Click the **Edit** icon.
      The section becomes editable.
   c. Edit the data.
   d. Click the **Apply** icon.
6. Click the **Save** button.
   If your user role permits you to save data without a review, the application saves the business entity to
   the MDM Hub Store as active records. Otherwise, the application saves the business entity as pending
   records and initiates the review process associated with your role.

**Adding and Editing Related Records**

Business entity relationships describe the affiliation between two entities. The MDM Hub supports one-to-
many and many-to-many relationships between business entities, in addition to hierarchical relationships
between records in the same business entity. You can add, view, edit, and manage relationships between a
business entity and the records related to the business entity.

When a relationship exists between two entities, you can add related records to a business entity. For
example, **Organization employs Person** is a relationship that exists between the Organization and Person...
business entities. You can add Person records or employees as related records to the Organization. The Related Records panel lists the business entities that are directly related to the business entity that is open in the Business Entity view.

**Note:** If you do not see the Related Records panel when you edit a business entity, contact the IDD application developer.

### Scenario for Adding and Editing Related Records

A relationship is configured between the Organization and the Person business entity types, such that an organization employs persons. You have an organization, Informatica, to which you want to add the employees. John Smith is an employee of Informatica.

You search for the Informatica business entity. You open the entity. You search for the Person business entity that represents John Smith. You add John Smith as a related record to Informatica. After an appraisal, John Smith has a different job title and salary. You must update the relationship details to reflect the change. You open the Informatica business entity and select the relationship between Informatica and John Smith. You update the relationship details.

### Adding a Related Record

When a business entity has relationships configured, you can add related records to the business entity. Search for and open the entity in a Business Entity view. Search for the related entity that you want to add as a related record and add the record in the Related Records panel.

**Note:** The Related Records panel must be present in the Business Entity view.

1. From the **Search Results** panel of the **Search** workspace, select the business entity to which you want to add the related records.
2. Open the business entity.
   - The **Related Records** panel displays the business entities records that are directly related to the business entity you open. There might be more than one Related Records panel.
3. In the **Related Records** panel, click **New**.
   - The **Relationships** dialog box opens.
4. Select the relationship type.
5. In the **Search** box, type the complete search string or the search string with the asterisk wildcard character (*) for the business entity that you want to find.
6. Click **Search**.
The following image shows the search results and the filter panel:

7. In the Filters panel, select a value for the filter criteria that you require.
8. Click Apply Filter.

The revised search results appear in the Search Results panel based on the filters you set.

The following image shows the filtered entities:

9. Select the business entity that you want to add as related record and click Select.
10. If the relationship has additional attributes, specify the additional attributes.
    For example, for a PersonOwnsAutomobile relationship, you might have to specify the mileage and price.
11. Click Apply.

The business entity is added as related record and appear in the Related Records panel.
The following image shows the related records in the Related Records panel:

Viewing Related Records

To view the records related to a business entity, search for and open the business entity. You can view the related records in the Related Records panel. Each related business entity in the component is a link that you can open in an Entity View.

1. From the Search Results panel of the Search workspace, select the business entity.
2. Click Entity View.
   The related records are listed in the Related Records panel.

Deleting a Related Record

You can delete the relationship between a business entity and a related record. Search for the business entity and then delete the related record in the Related Records panel.

1. From the Search Results panel of the Search workspace, select the business entity that you want to edit.
2. Open the business entity.
   The Related Records panel displays the business entities records that are directly related to the business entity you open. There might be more than one Related Records panel.
3. Select the related record that you want to delete, and then click the Delete icon.
   A confirmation box appears.
4. To delete the relationship, click Yes.
   Informatica Data Director deletes the relationship between the business entity and the related business entity and no longer displays the related record in the Related Records panel.

Editing the Relationship Details

You can edit the details of the relationship between a business entity and the related record. You can edit the additional attributes associated with the relationship. Search for the business entity and edit the relationship from the Related Records panel.

1. From the Search Results panel of the Search workspace, select the business entity that you want to edit.
2. Open the business entity.
The Related Records panel displays the business entities records that are directly related to the business entity you open. There might be more than one Related Records panel.

3. In the Related Records panel, select the related record that you want to edit, and then click the Edit icon.

4. Edit the additional attributes, and then click Apply.

   For example, assume that job title and salary are two attributes associated with the OrganizationEmploysPerson relationship. After an appraisal, you might edit the job title and salary for that Person record to reflect the changes.

Deleting a Business Entity

If your user role includes the delete permission, you can delete business entities in the active state. You cannot delete a business entity that is in the pending state because the entity is part of a workflow and is pending approval.

1. From the Search Results panel of the Search tab, select the business entity that you want to delete.

2. Open the business entity.

3. Click Actions > Delete.

   You are prompted to confirm the action.

4. To delete the business entity, click Yes.

   Informatica Data Director marks the entity as deleted and no longer displays the entity, but does not remove the entity from the database.
Resolving Duplicates Overview

The match process identifies matching business entities based on match rules. When you open the Matching Records view for a business entity, the IDD application retrieves data about the matching business entities from the matches table. You can also search for other similar business entities and add them to the view.

Note: The Matching Records view displays the matching records based on the data in the matches table. If a match job was not run recently, the matches table might not contain all the possible matches.

In the Matching Records view, you can review the records in the similar business entities. You start with the root records. If you identify duplicate business entities based on the data in the root records, select the business entities. The merge preview for the root record shows you the results of the proposed merge. Next, you can compare all the child and descendant records of the selected business entities. If some of the records contain different values for the same field, the merge preview process refers to the trust score for the data. The most trustworthy data is used in the merged business entity. At any time, you can open a preview of the merged business entity.

When you are sure that the merge preview reflects the best version of the truth, start the merge process. If your user role requires that someone else review the proposed merge business entity, Informatica Data Director saves the entity and starts a merge review workflow. When an authorized person approves the proposed merge, the MDM Hub updates the master data to reflect the merged business entity.

Note: You can override a trust score to use a value from another field. After you merge the records, select the Cross-reference Records view, choose the field you prefer, and save the business entity.
Match Process

The match process uses match rules to identify business entities that are similar to the entity that you opened in the Business Entity view. The degree of similarity among the business entities depends on how the match rules are defined.

The MDM Hub Administrator or a Data Steward defines the match rules in the Hub Console. Match rules identify the record columns to search and the type of match to use, that is, fuzzy or exact. For more information about match rules, see the Informatica MDM Multidomain Edition Configuration Guide.

This list of similar business entities is only a starting point. Business entities can be similar, without being duplicate records. You must review the records in the business entities and identify the duplicates.

Merge Process

To resolve duplicate business entities, you merge a target business entity with the duplicate business entities. The merge process creates a business entity that contains the most trustworthy data from all the participating business entities.

At the root level, the merge process merges the data in the root records of the business entities.

At the child level, when the parent-to-child relationship is a one-to-one relationship, the merge process merges the child records. When the relationship is a one-to-many relationship, you can select the child records to merge from the Matching Records view. All records that are not selected for a merge are added to the merged business entity.

Note: IDD application developers define the parent-to-child relationships when they define the structure of the business entity.

After the merge process handles a child record, it tries to merge each level of descendant records using the same merge strategies. The merge process must run successfully on a level before the process can try to merge the next level.

The following image shows how the merge process works on three business entities, where each entity has a root record and two child-level relationships:

The merged business entity contains the merged root record, the merged child records, and all the records that were not merged.
Scenario for Duplicate Business Entities

You work for an insurance organization. A customer, Paula Laine, calls to review her home insurance policy. You ask Ms. Laine for her policy number, and enter the policy number in the Search bar.

In the search results, you select the business entity that contains the policy number, and open the business entity in the Business Entity view. You confirm a few personal details and then answer Ms. Laine's questions about her policy.

After you answer her questions, you ask Ms. Laine if she has any other policies. Ms. Laine tells you that she has an automobile policy registered with a subsidiary of your organization. You enter the automobile policy number in the Search bar, and the search returns the business entity that contains the automobile policy. You verify that the personal data matches the data in the other business entity.

After you end the conversation, you open the business entity that contains the home policy in the Matching Records view. From the similar business entities, you select the entity that contains the automobile policy. You click Preview and verify that both policies appear in the Policies section. In addition, you can see that the merged business entity is more complete overall, with data such as Ms. Laine's middle name and her mobile phone number coming from different source records. When you are satisfied that the merge preview represents the best version of the truth, you start the merge process.

Resolving Duplicate Business Entities

Use the Matching Records view to compare similar business entities. When you identify records that are duplicates, you can resolve the duplicates by merging the records.

To identify and resolve duplicate business entities, perform the following tasks:

1. "Identify Duplicate Business Entities" on page 41
   Review the suggested similar business entities and, optionally, find other business entities that you think might be matches. Select duplicates.

2. "Identify Duplicate Child Records" on page 42
   After you select duplicate business entities, the Navigate menu updates to include the child records and descendant records from the duplicate business entities. Review the child records. Select duplicates.

3. "Merge Duplicate Business Entities" on page 43
   Start the merge process.

Identify Duplicate Business Entities

Compare the data in a target business entity with similar business entities in the Matching Records view. Start with the root record, then use the Navigate menu to open the child records and their descendant records.

Initially, the Navigate menu reflects the structure of the target business entity. After you select duplicate business entities, the merge preview shows the result of merging the root records of the target and duplicate business entities. The merge preview process applies the merge cascade rules to the child records and
descendant records. The structure in the Navigate menu changes to reflect the structure of the proposed merged business entity.

1. With a business entity open, select **Matching Records**.

   The **Matching Records** view opens with the target business entity in the second column. The first column contains the **Merge preview**. The remaining columns contain the business entities that satisfy a match rule that is associated with the records of the target business entity. The row labels in the grid correspond to the column names in the root record.

2. Optionally, show only the business entities that satisfied a specific match rule.
   a. Click the **Filter** tab.
   b. Select **Specify a match rule**.
   c. Click in the field and select the match rule from the list.

   **Tip:** If the list is empty, the records of the target business entity have no match rules.

3. If you think that the match process missed a similar business entity, you can add it.
   a. Click **Add**.

      The **Find and select entities** page opens.
   b. Type the text or value that you want to find, and click **Search**.
      The search returns all business entities that contain the search term.
   c. Optionally, select filters to restrict the search results and click **Apply Filter**.
   d. Expand the details for a business entity by clicking the plus icon beside the name.
   e. Select the business entities that you want to add.
   f. Click **Select**.

      The business entities appear in the **Matching Records** view. If a business entity is already displayed in the view, it is not added again.

4. Compare the data in the root records across all the similar business entities.

5. Optionally, to change the fields displayed for each business entity, click the **View** button. For example, you can show or hide the system columns.

6. When you determine that a business entity is a duplicate of the target business entity, select the check box in the column header for that entity. You can select more than one business entity.

   The **Merge preview** shows the result of merging the root records.

7. Click **Preview**.

   The **Business Entity Preview** opens. The preview shows the result of merging the records that belong to the target and duplicate business entities.

8. To close the preview, click **Back**.

   You return to the **Matching Records** view.

**Identify Duplicate Child Records**

After you preview the merge of duplicate business entities, review the child records and their descendant records in the **Matching Records** view. Select a record from the target business entity as the target record. You can select one or more duplicate records to merge with the target record.

**Note:** As you work with the child records, you might find data that makes you decide that a business entity is not a duplicate after all. You can return to the Overview screen and clear the check box for that business entity. The merge preview process regenerates the Merge Preview. The merge preview process keeps any
manual merges that you created among the records in the remaining business entities. If a manual merge contained records from the removed business entity, those records are removed from the manual merge.

1. In the Navigate tab, expand a node and select a child record from the target business entity.
   The grid changes. The second column contains the selected child record, which is the target record. The remaining columns display the sibling records.
   **Tip:** If a pending icon appears in the column header for the target record, the record is in the pending state and cannot participate in a merge process. Select a different record as the target record.
   For example, you might see multiple telephone numbers for the target business entity plus all the telephone numbers that belong to the duplicate business entities.

2. If you see a sibling record that is a duplicate of the target record, select the check box in the column header. You can select more than one record.
   **Tip:** If a pending icon is shown instead of the check box, the record is in the pending state and cannot be selected for a merge.
   The Merge Preview column shows the result of merging the target record with the duplicate records.

3. Repeat the process on the remaining child records. Optionally, you can perform the same process on descendant records.

4. Click Merge.

5. In the Merge Duplicates dialog box, confirm the merge.
   A manual merge request is saved in an internal change list.

### Merge Duplicate Business Entities

After you select duplicate child records and descendant records for manual merges in the Matching Records view, start the merge process.

1. In the Navigate tab, click Overview.
   You can see the root records in the view.

2. Optionally, preview the proposed merged business entity.
   a. Click Preview.
   b. Review the proposed merged entity. The Preview is similar to the Business Entity view.
   c. Click Back.

3. Click Merge.
   Based on your user role, one of the following actions occurs:
   - If your user role permits you to merge business entities without a review, the merge process merges the records in the selected business entities. The merged records are in the active state.
   - If your user role requires a review process, the merge process starts the merge review workflow. The records that will participate in the merge remain in the active state, but the merge occurs only after the merge proposal is approved.

4. Optionally, you can override a value that was selected based on its trust score.
   a. After merging the records, select Cross-reference Records from the View list.
   b. Select the field value that you think is the most accurate or enter a value manually.
   c. Click Save.
To look for duplicate records within a single business entity, open the business entity in the `Matching Records` view. Do not select any other business entities.

1. With the business entity open, select `Matching Records` from the View list.
   In the grid, the second column contains the selected business entity. In this scenario, ignore any similar business entities.

2. In the `Navigate` tab, expand a node and select a child record from the business entity.
   The grid changes. The second column contains the selected child record, which is the target record. The remaining columns contain the sibling records, if any.

3. If you see a sibling record that is a duplicate of the target record, select the check box in the column header. You can select more than one record.
   The `Merge Preview` column shows the result of merging the target record with the duplicate records. The merge request is saved in an internal change list.

4. Repeat the process on the remaining child records. Optionally, you can perform the same process on descendant records.

5. In the `Navigate` tab, click `Overview` to return to the root record.

6. Click `Merge`, and then confirm the merge.
   The merge process implements the manual merge requests on the sibling records. Based on your user role, one of the following actions occurs:
   - If your user role permits you to merge business entities without a review, the merge process merges the records. The merged records are in the active state.
   - If your user role requires a review process, the merge process initiates the merge review workflow. The records that will participate in the merge remain in the active state, but the merge occurs only after the merge proposal is approved.
Establishing the Best Version of the Truth

This chapter includes the following topics:

- Master Records and the Best Version of the Truth, 45
- Scenario, 45
- Establish the Best Version of the Truth, 46
- Unmerge Cross-reference Records, 47

Master Records and the Best Version of the Truth

Master records in the MDM Hub maintain the best version of the truth. The MDM Hub consolidates the most trustworthy data from several source systems into each master record to achieve the best version of the truth.

The MDM Hub stores source data in cross-reference records. In the Cross-reference Records view, a data steward can examine these cross-reference records and investigate which source data contributes to the master record. Data stewards can then make adjustments to how source data is consolidated to ensure that the master record represents the best version of the truth.

The MDM Hub calculates a trust score for the fields in the cross-reference records. The trust calculation is based on settings and rules that are establish by an administrator. For more information about configuring the rules that govern trust score calculations, see the Informatica MDM Multidomain Edition Configuration Guide.

Scenario

A data steward investigates why customer data in a master record does not represent the best version of the truth.

The phone number for a customer has recently changed to 555-5555. None of the cross-reference records contain this phone number, so the data steward selects the phone number field in the master record and enters the correct phone number.

A master record for a customer record shows the middle name of a customer as ‘Stacy’. In fact, the correct spelling of the middle name is ‘Stacey’. The data steward sees that a cross-reference record contains the
correct spelling but does not contribute to the master record. The data steward selects the field with the correct spelling as the contributor to the master record.

The master record that represents Joe Smith actually contains two cross-reference records that represent customers who are not Joe Smith. The data steward unmerges these two mismatched cross-reference records from the master record representing Joe Smith. Master records are created from the unmerged cross-reference records.

Establish the Best Version of the Truth

Data stewards can use the Cross-reference Records view to examine the composition of the master record. Data stewards can then make adjustments to ensure the master record genuinely represents the best version of the truth.

If the most trusted fields do not contain the best data, a data steward can perform the following actions to establish the best version of the truth:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>How-to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the correct value</td>
<td>If the correct value does not exist in any cross-reference record, a data steward can enter the correct value in the master record.</td>
<td>Click the incorrect value in the Master Record column, and then enter the correct value. Press Enter, and then click Save.</td>
</tr>
<tr>
<td>Select the correct contributing field</td>
<td>If the field with the highest trust score does not contain the best version of the truth, a data steward can select the field that does contain the correct data to contribute the data to the master record.</td>
<td>Click the field that contains the correct data. Click Save</td>
</tr>
<tr>
<td>Remove mismatched source data</td>
<td>If a cross-reference record should not be associated with a particular master record, a data steward can unmerge the cross-reference record. A new master record is created from the unmerged cross-reference record.</td>
<td>Select the checkbox for the cross-reference records that contain the mismatched data, and then click Unmerge. For more information about unmerging, see “Unmerge Cross-reference Records” on page 47.</td>
</tr>
</tbody>
</table>

The following image shows the ways in which data stewards can establish the best version of the truth:

1. Enter the correct value
2. Select the correct contributing field
3. Select a cross-reference record to unmerge
If a cross-reference record should not be associated with a particular master record, a data steward can unmerge the cross-reference record. A new master record is created from the unmerged cross-reference record.

The following illustration shows the unmerge behaviour when a cross-reference record is unmerged from a master record that is comprised of five cross-reference records:
Investigating Data Changes

This chapter includes the following topics:

- Investigating Data Changes Overview, 48
- Investigating Data Changes Scenario, 48
- Comparing Data Before and After Events, 49

Investigating Data Changes Overview

You can compare the best version of the truth at different moments in time for a particular business entity. If you suspect that the data in the business entity has changed inappropriately, you can use the History view to identify the data event that caused the data change.

The History view displays a chronology of data changes over the lifespan of the business entity. You can view the data that existed in the business entity at any point in time in the chronology. View the data before a data event and after a data event to determine if the event caused the inappropriate data change. A data event is any action that changes the data in a business entity, such as an edit or a merge operation.

Investigating Data Changes Scenario

A customer reports that he recently changed his email address and he wants to confirm that you have his current contact details. You look in the History view for the business entity that represents this customer.

The customer stated that he changed his address in October of the current year, so you look for data events in the History view chronology that occurred around that time. You see that multiple data events occurred in October for the business entity that represents the customer. You navigate to the Email child record and compare the data before and after the data events. You see that the new email address for the customer was added. After further investigation, you see that the middle name of the customer was added.
Comparing Data Before and After Events

Use the History view to compare changes to master data.

1. With the business entity open, select **History**.
   The History view opens. Changes to the business entity appear on the timeline.
2. Optionally, select filters to show or hide different types of events.
3. Optionally, select a time unit to group data events. To do this, click **Options** and choose a different timescale. For example, select **M** to select a monthly timescale.
   The following image shows data events grouped under the month of October:

4. Click the event labeled **Email**.
   The event details panel shows the business entity details before and after the event and the time when the business entity was updated. In this example, the email address has changed from jsmith@example.com to jxsmith88@example.com.
5. Click the event labeled **SMITH, JOHN**.
   The following image shows that the display name of the business entity changed from John Smith to John Xavier Smith.
CHAPTER 8

Investigating Hierarchies and Relationships

This chapter includes the following topics:

- Investigating Hierarchies and Relationships Overview, 50
- Opening a Business Entity in the Hierarchy View, 50
- Displaying Entities and Relationships on the Canvas, 51
- Investigating Related Entities, 56
- Changing Entities and Relationships for a Business Entity, 59
- Sharing the Hierarchy View of a Business Entity, 61

Investigating Hierarchies and Relationships Overview

A business entity can have relationships to other business entities. When the Hierarchy Manager is enabled in an IDD application, you can view a graph that shows how a business entity is related to other business entities.

Use the Hierarchy view to investigate relationships and the related business entities.

Opening a Business Entity in the Hierarchy View

Use the Hierarchy view to examine the relationships between the open business entity and other business entities.

To open a business entity in the Hierarchy view, perform one of the following actions:

- In a Search tab search results, select a business entity. From the Actions menu, click Hierarchy.
- In the entity tab that displays an opened business entity, click Hierarchy from the toolbar.
- In the Data tab search results, select one or more business entities and click Open Hierarchy.
- In the Data tab, open a business entity and click Open Hierarchy.

The Hierarchy view opens. The selected business entity and the related business entities appear on the canvas.
Displaying Entities and Relationships on the Canvas

You can change the way that entities and relationships appear on the Hierarchy canvas. You can change the layout, create and apply filters, hide or show related entities, or change other canvas display options.

Selecting a Layout

Different layouts can reveal different insights into business entity relationships. You can customize the size and spacing in some of the layouts.

1. In the canvas, click the **Layouts** tab.
   The **Layout** panel opens.
2. Click a layout icon.

<table>
<thead>
<tr>
<th>Layout</th>
<th>Layout Name</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Hierarchy Layout" /></td>
<td>Hierarchy.</td>
</tr>
<tr>
<td><img src="image2" alt="Tree Layout" /></td>
<td>Tree.</td>
</tr>
<tr>
<td><img src="image3" alt="Circular Layout" /></td>
<td>Circular.</td>
</tr>
<tr>
<td><img src="image4" alt="Taxonomy Layout" /></td>
<td>Taxonomy.</td>
</tr>
<tr>
<td><img src="image5" alt="Network Layout" /></td>
<td>Network.</td>
</tr>
<tr>
<td><img src="image6" alt="Explorer View Layout" /></td>
<td>Explorer View.</td>
</tr>
</tbody>
</table>

3. Click **Apply**.
   The canvas displays the entity relationships in the selected layout. If you can customize the layout, one or more options appear in the **Layouts** panel.
4. To customize the layout, set the layout options.
   - To increase a value, move the slider to the right, and then click **Apply**.
   - To decrease a value, move the slider to the left, and then click **Apply**.
• In the Network layout, you can choose whether to show spheres of influence. When selected, the **Sphere of influence** option encloses each entity in a circle. The size of the circle reflects the number of direct relationships held by each entity. The more direct relationships, the larger the circle.

**Filtering Entities and Relationships**

Use filters to show or hide a set of entities and relationships. For example, you might want to simplify the view so that you can focus on a particular relationship.

**Defining a Filter**

Use the **Filters** panel below the canvas to select filter options to apply to the canvas.

To enable a filter option, select the option check box. To disable a filter option, clear the check box. Filter options are cumulative. You can select as many or as few as you need to clarify the relationships on the canvas. In logical terms, filters are joined by the **AND** operator.

1. In the **Hierarchy** view, click the **Filters** tab that is located below the canvas.
   
   The **Filters** panel opens.

2. In the **Hierarchies** section, select the check boxes for one or more types of business entities.
   
   The filter affects all selected types of business entities.

3. Click the name of a business entity type.
   
   The relationship filter options for the selected business entity type appear to the right. The Informatica Data Director application developer defines the list of filter options.

4. Optionally, change the relationship filter options for the entity.

5. Optionally, click **General** and change the general filter options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide unconnected entities</td>
<td>Hides entities with no relationship to the selected business entity.</td>
</tr>
<tr>
<td>Show pending relationships</td>
<td>Shows relationships that are currently under review.</td>
</tr>
</tbody>
</table>

6. Optionally, click **Relationship Directions** and change the directional filter options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Parents</td>
<td>Shows the parents of the selected business entity.</td>
</tr>
<tr>
<td>Show Children</td>
<td>Shows the child entities of the selected business entity.</td>
</tr>
<tr>
<td>Show Unknown</td>
<td>Shows entities where the relationship between the entities is unknown.</td>
</tr>
<tr>
<td>Show Undirected</td>
<td>Shows related entities where the type of relationship is not specified.</td>
</tr>
<tr>
<td>Show Bidirectional</td>
<td>Shows related entities where the direction of the relationship goes both ways.</td>
</tr>
</tbody>
</table>

7. Click **Apply**.

   The application applies the selected filter options to the canvas.
**Saving a Filter**

If you expect to reuse the filter options that you applied to the canvas, save the options as a filter. After you save a filter, you can choose to make the filter the default filter whenever the selected entity is displayed in the canvas.

1. In the **Filters** panel, click **Saved Filters**.
2. Type a name in the **Filter Name** field.
3. To share the filter with colleagues, select **Public**.
4. Click **Save**.
   - The filter options that are currently applied to the view are saved.
5. To always apply this filter with the selected entity, click the **Default for Entity** button.

**Applying a Saved Filter**

When you apply a saved filter, the filter applies to the types of business entities selected in the filter.

1. In the **Filters** panel, click **Saved Filters**.
2. Select the filter from the **Filter Name** list.
   - The filter options reflect the settings in the selected filter.
3. Click **Apply**.
   - The canvas reflects the settings in the applied filter.

**Applying a Default Hierarchy Filter**

When you apply a default hierarchy filter, the filter applies to the selected business entity type.

1. In the **Filters** panel, click **Defaults**.
2. Select the filter from the **Default hierarchy** list.
   - The filter options reflect the settings in the selected filter.
3. Click **Apply**.
   - The canvas reflects the settings in the applied filter.

**Deleting a Saved Filter**

You can delete saved filters that you no longer use. If the filter is public, check with colleagues before you delete it.

1. In the **Filters** panel, click **Saved Filters**.
2. Select the filter from the **Filter Name** list.
   - The filter options reflect the settings in the selected filter.
3. Click **Delete**.
Hiding and Showing Entities on the Canvas

You can hide or show selected entities and entity relationships on the canvas. When you hide an entity in the canvas, the entity relationship to the primary business entity remains intact, but the entity relationship is not shown on the canvas.

After you hide an entity, the Hierarchy view updates the remaining entities that are related to the hidden entity. In the canvas, the related entities show the number of visible relationships out of the total number of relationships, and display a plus sign icon to show that some relationships are hidden. In the relationship table, the row that represents the hidden entity does not have a canvas icon.

The following image shows the canvas and the relationship table where some entities are hidden:

Showing Direct and Indirect Relationships

In the Hierarchy view, direct and indirect relationships between entities are expressed in hops. A hop is a relationship between entities. A direct relationship is one hop, while an indirect relationship is more than one hop. For example, given entities A, B, C, and D, the relationship A--D is one hop, A--B--D is two hops, and A--B--C--D is three hops. You can change the number of hops that appears for a selected entity.

1. In the canvas, click an entity.
   - The Actions button appears.
2. Perform one of the following actions:
   - To view direct relationships, click the Actions button and click Fetch > One Hop.
   - To view direct and indirect relationships, click the Actions button and click Fetch > Many Hops (#).
3. Optionally, you can change the number of hops that are shown by the Many Hops (#) option.
   a. Click the Actions button and click Fetch > Preferences.
   b. In the Show Many Hops dialog box, set a value between 2 and 20.
   c. Click Execute.
   d. In the entity box, click the Actions button.
      - The Many Hops (#) menu item reflects the value that you set.
   e. To apply the new number of hops to the canvas, click Fetch > Many Hops (#).

Hiding an Entity

If the graph is complex, you can simplify the graph by hiding entities that are not meaningful to your investigation. When you hide an entity, the entity and the entity relationships are hidden. You cannot hide the primary business entity or an entity that functions as the anchor of the graph in the canvas.

1. In the canvas, click the entity.
   - The entity Actions button appears.
2. Click Actions.
3. Click Hide > Hide Entity.
   - In the canvas, the entity and the entity relationships are hidden.
Hiding Selected Entities
Select one or more entities to hide. You cannot hide the primary business entity or an entity that functions as the anchor of the graph in the canvas.

1. In the canvas, select entities by pressing the *Ctrl* key and clicking the entities.
   Selected entities are highlighted.
2. On the toolbar, click the **Actions** icon, and then click **Hide Selected Entities**.
   In the canvas, the selected entities and the entity relationships are hidden.

Hiding the Children of an Entity
You can hide the children of a selected entity. To qualify as a child entity, the Direction type of the child entity must be Child.

1. In the canvas, click the entity.
   The entity Actions button appears.
2. Click **Actions**.
3. Click **Hide > Hide Children**.
   In the canvas, the children of the selected entity are hidden.

Showing a Hidden Entity
You can show a hidden entity and the entity relationships in the canvas.

1. In the canvas, click an entity.
2. If the relationship table is closed, click the arrow button to open the relationship table.
   The relationship table displays all entities that are directly related to the selected entity.
3. In the relationship table, select the hidden entity that you want to show in the canvas.
4. Right-click and click **Add to Canvas**.
   In the canvas, the entity and the entity relationships are displayed.

Showing All Hidden Entity Relationships
When an entity box includes a plus sign icon in the lower left corner, the entity has relationships to hidden entities. You can show all the hidden entities.

- To show all hidden entities, click the **Show** icon in the entity box.
  The hidden entities and the entity relationships are shown on the canvas.

Navigating the Canvas
In the canvas, you can zoom in or out on the graph, move around the graph, or move quickly to another part of the graph.

- To zoom in or out on the graph, move the slider up or down.
- To view hidden adjacent parts of the graph, use the direction arrows to move the hidden entities into view.
• To navigate quickly through a large hierarchy graph, click the **Navigation** tab and click a different area of the graph. The area appears in the canvas.

### Setting Canvas Options

You can set options that control the canvas.

• To increase the height of the canvas, click the **Full Screen Mode** icon. The application header and workspace bar are hidden.
• To show the canvas legend, click the **Other** tab. The legend appears on the left.
• To use simple graphics in the canvas when the number of entities exceeds a threshold, click the **Other** tab, set a threshold value, and click **Apply**.

### Investigating Related Entities

As you investigate the relationships for the selected business entity, you might need to review the details for a related entity or for a relationship.

You can view the following kinds of details:

• Entity data
• Source systems and pending records
• System columns
• Relationship details
• Hierarchy
• History of changes

### Viewing Entity Data

If you need more information about an entity, you can view the entity data. For example, when the hierarchy contains similar entities, you might want to confirm that you have the correct entity before taking an action.

1. In the canvas, click an entity.
   The entity Actions button appears.
2. Click **Actions**.
3. Click **View > Details**.
4. In the **Entity Details** window, review the summary details.
   • If the details are sufficient to allow you to continue your work, click **Close**.
   • If you need more information about the entity, click **More Details**. The entity opens in a new tab. You can review all the data about the entity and, if necessary, edit the data.
Viewing Source Systems and Pending Changes

You can view information about contributing source systems and pending changes for a selected entity. In the MDM Hub Store, the information is stored as cross-reference (XREF) records.

1. In the canvas, click an entity.
   The entity Actions button appears.
2. Click Actions.
3. Click View > Cross References.
4. In the Cross References dialog box, review records.
   • If the details are sufficient to allow you to continue your work, click Cancel.
   • If you need to make changes, edit values, and then click Save.

Viewing System Columns

Data stewards might be interested in viewing the values in the system columns for a selected entity. For example, you can view values for the Rowid Object column and Creator column.

1. In the canvas, click an entity.
   The entity Actions button appears.
2. Click Actions.
3. Click View > System Columns.
4. In the System Columns window, review the values.
5. When you are finished, click Close.

Viewing and Editing Relationship Details

If you need more information about a relationship, you can view details about the relationship, such as the relationship type.

1. In the canvas, click a relationship line.
   The relationship Actions button appears.
2. Click Actions.
3. Click View Relationship Details.
4. In the Edit Relationship dialog box, review the details about the relationship.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagram</td>
<td>Displays a diagram of the related entities and the direction of the relationship.</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>The type of the business entity, such as organization or household.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The type of relationships that are possible between the entities, such as employee or relative.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rel Start Date</td>
<td>The start date of the relationship. If the date occurs in the past, the relationship is active. If the date occurs in the future, the relationship will start on the specified date. If the field is empty, a start date was not set.</td>
</tr>
<tr>
<td>Rel End Date</td>
<td>The end date of the relationship. If the date occurs in the past, the relationship has ended and is inactive. If the date occurs in the future, the relationship will end on the specified date. If the field is empty, the relationship is currently considered permanent.</td>
</tr>
<tr>
<td>Switch Entities</td>
<td>You can switch the order of the entities to change the direction of the relationship. The Switch Entities button is enabled for some Relationship Types.</td>
</tr>
<tr>
<td>Other fields</td>
<td>Additional fields might appear for some Relationship Types.</td>
</tr>
</tbody>
</table>

5. Optionally, to change the relationship details, edit options and click Save.

**Viewing the Hierarchy for a Related Entity**

To view the relationships for a related entity, you can open the related entity in a Hierarchy view.

1. In the canvas, click an entity.
   The entity Actions button appears.
2. Click Actions.
3. Click Open in New Tab.
   A tab opens and displays the hierarchy for the selected entity.

**Viewing a History of Relationship Changes**

You can investigate how relationships have changed for the business entity that appears in the Hierarchy view.

1. On the toolbar, click the Actions icon, and then click Show History.
2. In the Change History window, below the timeline, drag the timeline slider to the period that you want to investigate. You can expand the period by extending the edges of the timeline slider.
   A box highlights the selected time period.
3. Right-click the timeline and click Select a Date.
4. In the Select a Date dialog box, select a date and time, and then click OK.
   An orange line marks the comparison date on the timeline. The left-side graph changes to reflect the graph as it looked on the selected date and time. The right-side graph continues to show the current version of the graph.
5. In the Relationships row of the timeline, look for change boxes.
   • If the row is empty, there are no changes.
   • Otherwise, pause on a change box to see a change summary. To see details, right-click the box and click View Event Details. In the Event Details window, review changes, and then click Close.
6. After you finish your investigation, click Close.
   The Change History window closes.
Changing Entities and Relationships for a Business Entity

In the **Hierarchy** view, you can add, edit, and delete related entities and relationships for the selected business entity. If an effective date is set, the update is valid for the selected effective date.

### Adding an Entity to the Canvas

To create a relationship to a business entity that is not on the canvas, search for the business entity and add it to the canvas.

1. On the toolbar, click **Add to Canvas**.
   - If you navigated to the Hierarchy view from an entity tab, the Smart Search dialog box opens. If you navigated to the Hierarchy view from the legacy Data tab, the Search dialog box opens.
2. If the **Smart Search** dialog box opens, perform the following steps:
   a. Optionally, select the type of business entity.
   b. Type the search term.
   c. Click **Search**.
      - If the search process finds matches, the matching business entities appear in the search results.
   d. Optionally, use the filters to narrow the search results.
   e. If the business entity appears in the search results, select the entity and click **Select**.
      - The entity appears on the canvas.
3. If the legacy **Search** dialog box opens, perform the following steps:
   a. Enter the search criteria.
   b. Click **Run Search**.
   c. If the business entity appears in the search results, select the entity and click **Add to Canvas**.
      - The entity appears on the canvas.
4. **Next steps.** Create a relationship between the added entity and other entities.

### Adding a Relationship

You can create a relationship between two unrelated business entities as long as a relationship type exists for the business entity types.

1. Ensure that both entities are visible on the canvas. You might need to use the slider to zoom out the canvas.
2. Drag and drop one entity box on top of the other entity box.
3. In the **Add Relationship** dialog box, configure the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagram</td>
<td>Displays a diagram of the related entities and the direction of the relationship.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>The type of the business entity, such as organization or household.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>The type of relationships that are possible between the entities, such as employee or relative.</td>
</tr>
<tr>
<td>Rel Start Date</td>
<td>The start date of the relationship. If the date occurs in the past, the relationship is active. If the date occurs in the future, the relationship will start on the specified date. If the field is empty, a start date was not set.</td>
</tr>
<tr>
<td>Rel End Date</td>
<td>The end date of the relationship. If the date occurs in the past, the relationship has ended and is inactive. If the date occurs in the future, the relationship will end on the specified date. If the field is empty, the relationship is currently considered permanent.</td>
</tr>
<tr>
<td>Switch Entities</td>
<td>You can switch the order of the entities to change the direction of the relationship. The Switch Entities button is enabled for some Relationship Types.</td>
</tr>
<tr>
<td>Other fields</td>
<td>Additional fields might appear for some Relationship Types.</td>
</tr>
</tbody>
</table>

4. Click **Save**.

In the canvas, a relationship line appears between the two entities. If the relationship is directional, the line includes an arrowhead to show the direction.

**Editing an Entity from the Hierarchy View**

As you work with related entities in the **Hierarchy** view, you might find that you need to edit data.

1. In the canvas, click an entity.
   
   The entity Actions button appears.
2. Click **Actions**.
3. Click **Edit > Edit Entity**.
   
   A tab opens and displays the entity in the **Data** view.
4. Edit data as required and save the changes.
5. To return to the **Hierarchy** view, click the tab that contains the **Hierarchy** view.

**Deleting an Entity from the Hierarchy View**

As you work with related entities in the **Hierarchy** view, you might find that you want to delete an entity. When you delete an entity, the entity is removed from the view, and the entity records are marked for deletion in the MDM Hub Store. All the relationships between the deleted entity and the selected business entity are also deleted. You cannot delete the business entity whose hierarchy you are viewing.

1. In the canvas, click the entity that you want to delete.
   
   The entity Actions button appears.
2. Click **Actions**.
3. Click **Edit > Delete Entity**.
   
   The entity and the entity relationships are removed from the canvas and the relationship table. The entity is marked for deletion in the MDM Hub Store.
Deleting a Relationship

You can delete relationships between entities. You can delete the relationship immediately, or you can cause the relationship to expire with an end date.

The End Date Relationship option is available under the following circumstances:

- The end date is empty.
- The relationship belongs to the current source system specified for the application.
- One cross-reference record persists in the database for the current effective period where the record does not intersect with effective periods from other source systems.

You delete relationships from the canvas.

1. In the canvas, click the relationship line. The relationship Actions button appears.
2. Click Actions.
3. Choose how you want to delete the relationship.
   - To delete the relationship and mark it with an end date, click End Date Relationship. When prompted for confirmation, click Yes. The end date is set to the date before the selected effective date.
   - To delete the relationship from the selected effective period without adding an end date, click Delete Relationship.
   - To delete the relationship for all effective dates, click Delete All Relationship Periods.

The relationship line disappears and the relationship is deleted from both affected entities.

Sharing the Hierarchy View of a Business Entity

Saving an Image of the Graph

If you want to share a graph with colleagues, you can export it in JPEG format. You can then use the image in a report or in an email to interested colleagues.

The export process saves images to the browser's default directory for downloads.

1. Open a business entity in the Hierarchy view.
2. If you want to capture a portion of the graph, display the portion of the graph in the canvas.
3. On the toolbar, click the Actions icon, and then click Export to JPG.
4. In the Export Graph dialog box, choose how much of the graph to capture.
   - To capture the visible portion of the graph, select View Port.
   - To capture the entire graph, select Fit. Optionally, you can change the width and height of the image by using the sliders.
5. Click Export.

The export process creates the image and saves the image to the downloads directory.
This chapter includes the following topics:

- Participating in Review Processes Overview, 62
- Receiving Task Notifications, 66
- Claiming Tasks, 66
- Resolving Tasks, 67
- Organizing Work on Tasks, 71

Participating in Review Processes Overview

When a business user changes data in Informatica Data Director (IDD), the change triggers a review process. A review process is an automated business process that notifies business managers and data stewards when changes are ready for their review.

The type of review process depends on how the IDD application developer configured the IDD application and whether the default review processes are in use. By default, there are different review processes for edits, merges, and unmerges.

Example of a Review Process for Edits

The staff in the Finance department use Informatica Data Director to keep supplier banking information up to date. A supplier representative contacts a Finance staff member and requests a change to the supplier's banking information.

In the Finance department, each IDD user credential includes one of the following user roles:

- User. Staff members have permission to add and change business entities, but the changes must go through a review process before the master data is updated.
- Manager. A manager is a type of business user with additional permissions. A manager reviews changes, but cannot approve changes. If a manager agrees with a change, he escalates it to a senior manager.
- SrManger. A senior manager is a type of manager with additional permissions. A senior manager reviews changes and has the authority to approve them.

A staff member edits the supplier data as requested by the supplier representative. The following steps describe what happens during the review process.

1. A staff member changes the banking information of the supplier and saves the change. In the MDM Hub Store, the state of the supplier records changes from active to pending. The proposed edit is saved in a cross-reference record. The save action initiates the review process.
2. An instance of a review process starts and begins executing activities.

3. When the review process reaches the first people activity, it generates a task notification for managers. For example, in the default review process, the first people activity is Review No Approve. All managers with the role of Manager receive a task notification in the task inbox with the task type of Review No Approve.

4. A manager claims the task. The task is assigned to the manager and the task disappears from the task inboxes of the other managers.

5. The manager opens the supplier business entity, reviews the edit, and agrees with the edit. The manager resolves the task by clicking Escalate.

6. The review process marks the task as complete, and follows the Escalate flow to the next activity.

7. When the review process reaches the next people activity, the process generates a task notification for senior managers. For example, in the default review process, the second people activity is Final Review. All senior managers with the role of SrManager receive a task notification in the task inbox with the task type of Final Review.

8. A senior manager claims the task. The task is assigned to the senior manager and the task disappears from the task inboxes of the other senior managers.

9. The senior manager opens the supplier business entity, reviews the edit, and agrees with the edit. The senior manager resolves the task by clicking Approve.

10. The review process marks the task as complete, and follows the Approve flow. The review process notifies the MDM Hub that the change is approved, and then the review process ends. The MDM Hub changes the banking information in the supplier banking record. The supplier records change to the active state.

Task Manager

Use the Task Manager to organize, claim, and resolve tasks that are generated by review processes.

To go to the Task Manager, click the Task Manager tab. Alternatively, you can click a task link from the task inbox in the Start page. In this case, the Task Manager displays the selected task and the associated business entity.
The following image shows the **Task Manager** with a task selected:

1. Task inbox.
2. Review panel.

**Task Inbox**

A task is a request to participate in a review process. For example, you might need to approve a new business entity or review changes to a business entity. You receive task notifications in the task inbox. By default, the task inbox displays all available tasks. Available tasks include the tasks that are assigned to you and all unclaimed tasks.

The following image shows the task inbox:

1. Quick filters
2. Column filters
3. Sort by column heading
4. Refresh icon
5. Actions icon
The following table describes the elements in the task inbox:

<table>
<thead>
<tr>
<th>Inbox Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Filters**   | You can use the following types of filters alone or in combination:  
  - Quick filters. To see only your claimed tasks, select **My Tasks**. To see all tasks, select **Available Tasks**.  
  - Column filters. Filters the tasks based on the task properties that are visible in the list. Use only one column filter at a time. |
| **Refresh icon** | Updates the contents of the task inbox. |
| **Actions icon** | A menu of actions that you can perform on a selected task. After you claim a task, you can edit task details. |
| **Task Title** | A link that displays a short description of the review task. To review the business entity and take action on the task, click the task title. The business entity opens in the review panel. If your role permits it, you can edit the business entity from this view before taking action on the task. |
| **ID** | The instance ID of the review process that generated the task. |
| **Task Type** | The name of a people activity within the process. |
| **Priority** | The task priority can be Low, Normal, or High. When generating tasks, the review process assigns the same priority to all tasks of the same type. |
| **Due Date** | The date the task is due. The review process calculates a default due date based on the task creation date plus a predefined time period. |
| **Status** | The status of the task can be Open or Closed. When the task status is Open, you can view the business entity associated with the task. |
| **Owner** | The owner is the signed in user. You might also see Unclaimed tasks, which you can claim. |

**Review Panel**

Use the review panel to review the changed business entity. The content of the review panel differs based on the type of change that was made to the business entity.

The following image shows an edited business entity in the review panel:

![Review Panel Image]

1. Navigation menu  
2. Root record of the business entity  
3. Child section of the business entity
The following table describes elements in the review panel:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation menu</td>
<td>Displays the section names that contain child records or related business entities. For example, a customer business entity might contain sections called Addresses or Telephone Numbers. Click a section name to scroll to that section.</td>
</tr>
<tr>
<td>Root record of the business entity</td>
<td>Displays the root record of the business entity. For example, a customer root record contains the customer name.</td>
</tr>
<tr>
<td>Sections for child records</td>
<td>Sections contain child records.</td>
</tr>
<tr>
<td>Edited field</td>
<td>A change bar indicates the fields with changed data.</td>
</tr>
<tr>
<td>Edit button</td>
<td>Click to edit the business entity.</td>
</tr>
<tr>
<td>Image</td>
<td>Optionally, a business entity form can include an image. Displays the image found at the specified URL. Images are always linked. Images are not stored in the MDM Hub.</td>
</tr>
</tbody>
</table>

Receiving Task Notifications

A task is a request to participate in a review process. You might need to approve a new business entity or review changes to a business entity. You receive task notifications in the task inbox. Use the filters to help you organize your work.

You can find the task inbox in the Start page and also in the Task Manager. In the task inbox, you can see the tasks that you own and all unassigned tasks. Unassigned tasks are task notifications that were sent to all users with the same user role. You do not see tasks owned by other people.

**Related Topics:**
- "Task Manager" on page 63

Claiming Tasks

Often, more than one person shares the same reviewer role. You can let others know that you are working on tasks by claiming the tasks. Before claiming a task, check for comments. If someone else started work on this task and then disclaimed it, there might be important details in the comments.

1. Click **Task Manager**.
   - The task inbox contains a list of tasks.
2. Use the quick filter at the top of the task inbox to select what you want to see in the task inbox.
   - To see your claimed tasks, set the quick filter to **My Tasks**. Only your open tasks are displayed.
   - To see your claimed tasks and all unassigned tasks, set the quick filter to **Available Tasks**. Open and closed tasks are displayed.
3. Select a task where the Owner is shown as **Unclaimed**.
The business entity appears in the review panel.

4. Review the comments before claiming the task.
   a. Click **Task Details**.
   b. Read comments in the **All Comments** box.
   c. When you are done, click **Cancel**.

5. To assign the task to yourself, ensure the task is selected in the task inbox, and from **Actions** menu, click **Claim**.
   The task inbox is updated, and your user name appears in the Owner column for the task.

Resolving Tasks

You resolve a task by reviewing the new or changed business entity and then taking an action. The possible actions depend on the task definitions in the review process.

Reviewing Edited Business Entities

When you open a task to review an edited business entity, the fields that contain edited values are marked.

In the MDM Hub Store, the proposed edits are contained in a cross-reference record that is set to the pending state.

1. In the task inbox, click a task that is a request to review an edited business entity.
   The business entity appears in the review panel.
   **Note**: If you open an unassigned task, be sure to claim it before you start work.

2. Look for highlighted fields and decide if the edits are valid.

3. If you see a typographical error or an incorrect value for which you know the correct value, edit the field.
   **Note**: The next step depends on whether you have enough information to resolve the task or if you think someone else should assess it.

4. To resolve the task, click **Options** and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>If you agree with the edits and the task type permits you to approve changes, click <strong>Approve</strong>. The ActiveVOS® Server marks the related Final Review people activity as completed and performs the next activity in the process.</td>
</tr>
<tr>
<td>Escalate</td>
<td>If you agree with the edits, but the task type does not permit approval at this point in the workflow, click <strong>Escalate</strong>. The ActiveVOS Server marks the related Review No Approve people activity as completed and performs the next activity in the process.</td>
</tr>
<tr>
<td>Reject</td>
<td>If you disagree with the one or more edits, click <strong>Reject</strong> and type an explanation in the Comment box. The ActiveVOS Server notifies the person who edited the business entity. <strong>Note</strong>: If a source system updates the rejected entity, the entity goes through the approval process again.</td>
</tr>
</tbody>
</table>
If you see other options in the menu, then your organization uses a custom business process. If the purpose of the option is not clear and your role permits access to the ActiveVOS console, you can open the process to understand the workflow. Otherwise, contact the person who created the business process.

The task is closed.

5. To change the ownership of the task without resolving the task, click Options and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reassign | To ask another person to review the proposed changes, click Reassign, select the user, and type an explanation in the Comment box. The task is reassigned to the selected person.  
  **Note:** If this option is not available, click Task Details and select the user from the Assign to list. |
| Disclaim | To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the Comment box. Someone with the same role needs to take action on the task. |

The task remains open, but is no longer assigned to you.

**RELATED TOPICS:**
- “Claiming Tasks” on page 66
- “Task Manager” on page 63

**Reviewing New Business Entities**

When you open a task to review a new business entity, all field values in the business entity need to be validated. If you are one reviewer in a progressive multiple step review process, validate only the fields that you are responsible for validating.

In the MDM Hub Store, the parent record and child records are in the pending state until the new business entity is approved.

1. In the task inbox, click a task that is a request to review a new business entity.
   
   The business entity appears in the review panel.  
   **Note:** If you open an unassigned task, be sure to claim it before you start work.

2. Determine if the values in the business entity meet your business requirements.  
   **Note:** The next step depends on whether you have enough information to resolve the task or you think someone else should assess it.

3. To resolve the task, click Options and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve</td>
<td>If you think the business entity is acceptable, and the task type permits you to approve it, click Approve. The ActiveVOS Server marks the related Final Review people activity as completed and performs the next activity in the process.</td>
</tr>
</tbody>
</table>
### Action Description

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalate</td>
<td>If you think the business entity is acceptable, but the task type does not permit approval at this point in the workflow, click Escalate. The ActiveVOS Server marks the related Review No Approve people activity as completed and performs the next activity in the process.</td>
</tr>
</tbody>
</table>
| Reject | If you disagree with the one or more values, click Reject and type an explanation in the Comment box. The ActiveVOS Server notifies the person who added the business entity.  
**Note:** If a source system updates the rejected entity, the entity goes through the approval process again. |
| <Other> | If you see other options in the menu, then your organization uses a custom business process. If the purpose of the option is not clear and your role permits access to the ActiveVOS console, you can open the process to understand the workflow. Otherwise, contact the person who created the business process. |

The task is closed.

4. To change the ownership of the task without resolving the task, click Options and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reassign | To ask another person to review the proposed changes, click Reassign, select the user, and type an explanation in the Comment box. The task is reassigned to the selected person.  
**Note:** If this option is not available, click Task Details and select the user from the Assign to list. |
| Disclaim | To return the task to the pool of unassigned tasks, click Disclaim and type an explanation in the Comment box. Someone with the same role needs to take action on the task. |

The task remains open, but is no longer assigned to you.

**RELATED TOPICS:**
- "Claiming Tasks" on page 66
- "Task Manager" on page 63

### Reviewing Merge Proposals

When you open a task to review a merge proposal, the primary business entity appears beside the business entities that are selected for the merge.

1. In the task inbox, click a task that is a request to review a merge proposal.  
The business entity appears in the review panel.  
**Note:** If you open an unassigned task, be sure to claim it before you start work.  
2. Review the merge preview and determine if the merge is valid. The fields that appear in the merge preview are highlighted.  
**Note:** The next step depends on whether you have enough information to resolve the task or if you think someone else should assess it.
3. To resolve the task, click **Options** and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge</td>
<td>If you agree with the merge proposal and the task type permits you to approve changes, click <strong>Merge</strong>. The ActiveVOS Server marks the related Merge people activity as completed and performs the next activity in the process.</td>
</tr>
<tr>
<td>Reject</td>
<td>If you disagree with the merge proposal, click <strong>Reject</strong> and type an explanation in the Comment box. The ActiveVOS Server notifies the person who proposed the merge.</td>
</tr>
<tr>
<td>&lt;Other&gt;</td>
<td>If you see other options in the menu, then your organization uses a custom business process. If the purpose of the option is not clear and your role permits access to the ActiveVOS console, you can open the process to understand the workflow. Otherwise, contact the person who created the business process.</td>
</tr>
</tbody>
</table>

The task is closed.

4. To change the ownership of the task without resolving the task, click **Options** and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reassign</td>
<td>To ask another person to review the proposed changes, click <strong>Reassign</strong>, select the user, and type an explanation in the Comment box. The task is reassigned to the selected person. <strong>Note</strong>: If this option is not available, click <strong>Task Details</strong> and select the user from the <strong>Assign to</strong> list.</td>
</tr>
<tr>
<td>Disclaim</td>
<td>To return the task to the pool of unassigned tasks, click <strong>Disclaim</strong> and type an explanation in the Comment box. Someone with the same role needs to take action on the task.</td>
</tr>
</tbody>
</table>

The task remains open, but is no longer assigned to you.

**RELATED TOPICS:**
- "Claiming Tasks" on page 66
- "Task Manager" on page 63

## Reviewing Unmerge Proposals

When you open a task to review an unmerge proposal, a preview shows the result of the unmerge.

1. In the task inbox, click a task that is a request to review an unmerge proposal.
   The unmerge preview for the business entity appears in the review panel. **Note**: If you open an unassigned task, be sure to claim it before you start work.
2. Review the unmerge preview and determine if the unmerge is warranted. The fields that appear in the preview are highlighted. **Note**: The next step depends on whether you have enough information to resolve the task or if you think someone else should assess it.
3. To resolve the task, click **Options** and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unmerge</td>
<td>If you agree with the unmerge proposal and the task type permits you to approve changes, click <strong>Unmerge</strong>. The ActiveVOS Server marks the related Unmerge people activity as completed and performs the next activity in the process.</td>
</tr>
<tr>
<td>Reject</td>
<td>If you disagree with the unmerge proposal, click <strong>Reject</strong> and type an explanation in the Comment box. The ActiveVOS Server notifies the person who proposed the unmerge.</td>
</tr>
<tr>
<td>&lt;Other&gt;</td>
<td>If you see other options in the menu, then your organization uses a custom business process. If the purpose of the option is not clear and your role permits access to the ActiveVOS console, you can open the process to understand the workflow. Otherwise, contact the person who created the business process.</td>
</tr>
</tbody>
</table>

The task is closed.

4. To change the ownership of the task without resolving the task, click **Options** and select one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reassign</td>
<td>To ask another person to review the proposed changes, click <strong>Reassign</strong>, select the user, and type an explanation in the Comment box. The task is reassigned to the selected person. <strong>Note</strong>: If this option is not available, click <strong>Task Details</strong> and select the user from the <strong>Assign to</strong> list.</td>
</tr>
<tr>
<td>Disclaim</td>
<td>To return the task to the pool of unassigned tasks, click <strong>Disclaim</strong> and type an explanation in the Comment box. Someone with the same role needs to take action on the task.</td>
</tr>
</tbody>
</table>

The task remains open, but is no longer assigned to you.

**RELATED TOPICS:**
- "Claiming Tasks" on page 66
- "Task Manager" on page 63

**Organizing Work on Tasks**

When you have a long list of tasks, you can organize tasks by sorting and filtering the list, changing task properties, and assigning tasks to others.

For example, you might want to work on the tasks that have the highest priority or on the tasks that are due soonest. After you filter the list of tasks, you might find tasks that need a higher priority or that can be postponed. You can edit the task properties to better reflect the urgency within the business to resolve tasks. And, if you have the authority to assign tasks to managers, you can assign the task to a manager from the task properties.
 RELATED TOPICS:  
• "Task Manager" on page 63

Sorting and Filtering Tasks

You can sort and filter the list of tasks in the task inbox. For example, you might want to review edited business entities before you review merge proposals.

The task inbox contains quick filters and column filters. You can use these two types of filters in combination to get specific results. For example, to see high priority tasks assigned to you, select the My Tasks quick filter and set the Priority column filter to High. In logical terms, filters are joined by the AND operator.

Note: You can set one column filter at a time. For example, you can narrow your list to Organizations and then further restrict the results to show only the Merge tasks for organizations.

1. Click either the Start tab or the Task Manager tab.
   The task inbox appears.

2. To sort the list of tasks by an attribute, click the column heading with that attribute name.
   For example, to sort tasks by task type, click the Task Type column heading.
   Sorts the tasks based on the values in the selected column. An up arrow beside the column heading indicates that the values are sorted in ascending order. A down arrow indicates descending order.

   Note: By default, the task inbox sorts ActiveVOS tasks case-insensitively. If there are more than the value of the IDD global property CompositePagerTotalRecords to sort, case-sensitive sorting is database dependent. For more information about CompositePagerTotalRecords, see the Informatica MDM Multidomain Edition Informatica Data Director Implementation Guide.

3. To filter the list, set filter criteria in any order.
   • To filter tasks by the most commonly-used criteria, select a quick filter:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Tasks</td>
<td>Shows tasks that you own.</td>
</tr>
<tr>
<td>Available Tasks</td>
<td>Shows tasks that you own and tasks that are unassigned.</td>
</tr>
<tr>
<td></td>
<td>Note: You cannot view tasks that are assigned to other people.</td>
</tr>
</tbody>
</table>

   • To filter the task list based on an attribute in a column heading, set one column filter:

   Note: If the column filter fields are hidden, click Filter on to display the fields.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Title</td>
<td>Show tasks that contain the specified text. Enter the text that you want to search for in the task titles.</td>
</tr>
<tr>
<td>Type</td>
<td>Show tasks with the selected task type. Select a task type from the list, such as Final Review or Merge.</td>
</tr>
<tr>
<td>Priority</td>
<td>Show tasks with the selected priority, such as High. Select a priority from the list.</td>
</tr>
<tr>
<td>Due Date</td>
<td>Show tasks that are due before or by the selected date. Click the field and then select a date from the calendar.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Status</td>
<td>Show tasks with the selected status, such as Open or Closed. Select a status from the list.</td>
</tr>
<tr>
<td>Owner</td>
<td>Show tasks that are assigned to the user. Enter a user name.</td>
</tr>
</tbody>
</table>

4. To remove filters, click the Clear Filter icon.

**Editing Due Date, Priority, and Other Task Properties**

As you work with tasks, you might decide that some task properties need to be changed. For example, if changes are made to the record of an important client, you might want to increase the priority of the review task. Or, if you plan to be away and want to finish a set of tasks before you leave, you can change the due dates for the tasks to represent a date before your planned absence.

1. Click Task Manager.
2. In the task inbox, click the task you want to edit.
3. In the review panel, click Task Details.

The following image shows the Task Details dialog box:

![Task Details dialog box]

4. Edit one or more of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Title</td>
<td>A good title includes at least the name of the business entity and the change that initiated the review. Type a title that is more meaningful to you.</td>
</tr>
</tbody>
</table>
Assigning Tasks

If the IDD application implements a business process management (BPM) adapter that supports reassignment, you can assign tasks to other users. To find out if the BPM adapter used by the IDD application supports assignments, open the Task Details dialog box and see if the Assign to list is enabled.

1. Click Task Manager.

   The task inbox contains a list of your assigned tasks and all unassigned tasks.

2. Ensure that task inbox quick filter is set to Available tasks.

3. Click a task link.

   The business entity appears in the review panel.

4. Click Task Details.

5. In the Edit Task dialog box, review the comments in the All Comments box.

6. To assign the task, select the user from the Assign to list.

7. Click Save.

Disclaiming Tasks

If you claim or are assigned a task that you feel would be better handled by someone else, you can disclaim the task. Disclaimed tasks return to the pool of unassigned tasks. Use the Task Manager to disclaim tasks.

1. Click Task Manager.

2. In the task inbox, select an assigned task.

3. In the review panel, click Options > Disclaim.
Review Processes Reference

This appendix includes the following topics:

- Review Processes Reference Overview, 75
- Update With Approval Workflow, 76
- One Step Approval Workflow, 76
- Two Step Approval Workflow, 76
- Merge Workflow, 77
- Unmerge Workflow, 77

Review Processes Reference Overview

A review process is an automated business process. When a user adds, edits, merges, or unmerges business entities, the action can initiate a review process. A review process ensures that business managers or data stewards review and ultimately approve the data before it becomes master data.

Your user role determines whether a change to the master data triggers a review. For example, if your user role permits you to add or edit data but not approve changes, then when you save an edit or merge business entities, the action triggers a review process.

Informatica MDM Multidomain Edition ships with the following default review processes:

- Update with Approval Workflow
- One Step Approval Workflow
- Two Step Approval Workflow
- Merge Workflow
- Unmerge Workflow

Note: If you see different process names or task types in your task inbox, someone in your organization has changed the review processes or created custom processes.

The following sections describe the purpose of each review process and identify the people activities within each process. To view an entire process, open the process in the ActiveVOS Console.
Update With Approval Workflow

In the Update With Approval Workflow process, a data steward reviews the changed entity before either canceling the update or sending the update through a two-step approval process. The following table summarizes the people activities within the process:

<table>
<thead>
<tr>
<th>People Activity</th>
<th>Role Assigned</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update</td>
<td>DataSteward</td>
<td>A data steward reviews the update and either cancels the update or sends it through a two-step approval process.</td>
</tr>
<tr>
<td>Review No Approve</td>
<td>Manager</td>
<td>A manager reviews an update and either rejects it or sends it on for Final Review.</td>
</tr>
<tr>
<td>Final Review</td>
<td>SrManager</td>
<td>A senior manager reviews the update and either rejects it or approves it.</td>
</tr>
<tr>
<td>Notification</td>
<td>DataSteward</td>
<td>If approved, the data steward receives a notification that the update is approved.</td>
</tr>
</tbody>
</table>

One Step Approval Workflow

The One Step Approval Workflow process requires one senior manager to review and then approve or reject the update. The following table summarizes the people activities within the process:

<table>
<thead>
<tr>
<th>People Activity</th>
<th>Role Assigned</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final Review</td>
<td>SrManager</td>
<td>A senior manager reviews an update and either approves it or rejects it.</td>
</tr>
<tr>
<td>Notification</td>
<td>DataSteward</td>
<td>If the update is approved, the record is flagged for promotion and the data steward is notified.</td>
</tr>
<tr>
<td>Update</td>
<td>DataSteward</td>
<td>If the update is rejected, the data steward is notified and can cancel the update.</td>
</tr>
</tbody>
</table>

Two Step Approval Workflow

The Two Step Approval Workflow process requires at least two business managers to participate in the review and approval process. The following table summarizes the people activities within the process:

<table>
<thead>
<tr>
<th>People Activity</th>
<th>Role Assigned</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Review No Approve</td>
<td>Manager</td>
<td>A manager reviews an update and either rejects it or escalates it to Final Review.</td>
</tr>
<tr>
<td>Final Review</td>
<td>SrManager</td>
<td>A senior manager reviews the update and either approves it or rejects it.</td>
</tr>
</tbody>
</table>
Merge Workflow

When you select merge candidates, you can create a task that initiates the Merge Workflow process in the ActiveVOS Server.

The following table describes the people activity within the process:

<table>
<thead>
<tr>
<th>People Activity</th>
<th>Role Assigned</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge</td>
<td>DataSteward</td>
<td>A data steward reviews the candidates and either merges the records or cancels the action.</td>
</tr>
</tbody>
</table>

Unmerge Workflow

When you unmerge records, you can create a task that initiates the Unmerge Workflow process in the ActiveVOS Server.

The following table describes the people activity within the process:

<table>
<thead>
<tr>
<th>People Activity</th>
<th>Role Assigned</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unmerge</td>
<td>DataSteward</td>
<td>A data steward reviews the candidate and either unmerges the records or cancels the action.</td>
</tr>
</tbody>
</table>
INDEX

A
application header 13
assigning
tasks 74

B
best version of the truth about 10
business entities
about 10
adding 22, 24
deleting 38
edited, reviewing 67
ing add 27, 33
filtering 31
identifying duplicates 41
matching 39
merging duplicate 43
new, reviewing 68
opening 32
resolving duplicate 43
scenario for adding 21
scenario for duplicate 41
searching 27, 29
searching and editing example 29
viewing 32
business entity relationships
example 35
business entity relationships editing
adding 34
BVT
about 10

data changes (continued)
overview 48
data entry forms
Business Entities view, using 22, 24
data sources
best version of the truth 10
data validation
Business Entity view 21
deleting
business entities 38
duplicates
identifying 41
resolving 39

eediting
business entities 27, 33
overview 27
entities
adding, to Hierarchy canvas 59
business 10
external URLs
about 17

F
feeds
social media 16
filtering
business entities 31
filters
Hierarchy view 52
tasks 19, 72

G
golden profile
about 10
golden record
about 10

H
hierarchies
investigating 50
Hierarchy canvas
entities, hiding selected 55
direct and indirect relationships, showing 54
displaying entities and relationships 51
entities, hiding 54
tentities, showing 54

dC

canvas, Hierarchy See Hierarchy canvas
child records
merging 42, 44
claiming
tasks 66
compare
about 11
composite objects See business entities
concepts
master data management 10

D
data changes
before and after, comparing 49
History view, viewing 49
Hierarchy canvas (continued)
   entities, showing all hidden 55
   entity children, hiding 55
   entity, adding 59
   entity, showing a hidden 55
   hops, showing 54
   layout, selecting 51
   navigating 55
   options, setting 56

Hierarchy view
   entities, deleting 60
   entities, editing 60
   entities, viewing hierarchy of related 58
   entity data, viewing 56
   entity system columns, viewing 57
   filter, saving 53
   filters, applying default 53
   filters, applying saved 53
   filters, defining 52
   filters, deleting saved 53
   history of changes, viewing 58
   JPEG image, saving 61
   opening 50
   pending changes, viewing 57
   relationship details, viewing 57
   relationship, creating 59
   relationships, deleting 61
   source systems, viewing 57

History view
   data changes, investigating 48
   hops
      showing, in the Hierarchy canvas 54

I
   IDD application
      about 9
   IDD application developer
      about 9
   images
      Hierarchy canvas, saving 61
   Informatica Data Director
      about 9
   interface
      about 13
         language, change 12

J
   Jaspersoft reports
      about 16
   JPEG
      Hierarchy canvas 61

K
   key concepts
      about 10

L
   language
      changing 12
   localized
      user interface 12
      logging in 12

M
   master record
      about 45
   match process
      about 40
   Matching Records
      overview 39
      merge
         about 11
         task, reviewing 69
      merge process
         entity 360 framework 40
      merging
         child records 42, 44
         duplicate business entities 43

N
   notifications
      task 66

O
   objects
      base 10
      composite See business entities

P
   password
      changing 12
   processes
      match 40
      merge 40
      review, about 11

R
   related records
      adding 35
      deleting 37
      editing 37
      viewing 37
   relationships
      adding, in Hierarchy view 59
      deleting, in Hierarchy view 61
      history of changes, viewing 58
      investigating 50
   reports
      Jaspersoft 16
      review panel
      about 65
      review processes
      about 11
      edit review process, example 62
S
scenario adding business entities 21
search for business entities 27, 29
search and compare about 11
search engine about 17
Search page 27
searching overview 27
searching and editing example 29
signing in 12
social media feeds about 16
source systems best version of the truth 10
Start page about 15
external URLs 17
Jaspersoft reports 16
refreshing data 18
search engine 17
social media feeds 16
subject area 10
system columns Hierarchy view, viewing 57

T
tabs Search 27
task inbox about 17, 64
tasks about 11
tasks (continued) assigning 74
claiming 66
disclaiming 74
edited business entities, reviewing 67
filtering 19, 72
merge proposals, reviewing 69
new business entities, reviewing 68
notifications, receiving 66
ownership 66
ownership, setting 74
resolving 67
sorting 19, 72
unmerge proposals, reviewing 70

U
UI language, changing 12
unmerge task, reviewing 70
user interface about 13

V
validation data, Business Entity view 21

W
workflows review processes 11